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Preface

This section describes the purpose and organization of this guide: Getting Started
with the Oracle Standard Management Pack. Specifically, it covers the following topics:

■ Purpose of This Guide

■ Audience

■ How This Guide Is Organized

■ Conventions Used in This Guide

■ Oracle Enterprise Manager Pack Information

■ Oracle Enterprise Manager Documentation

Purpose of This Guide
This guide provides an overview of the Oracle Standard Management Pack
applications and their features.  As the guide describes how to use the Oracle
Standard Management Pack applications, it also introduces you to key concepts and
terminology in the following products: Oracle Performance Manager, Oracle Index
Tuning Wizard, Oracle Baseline Viewer, Oracle Change Manager, Oracle DB
Capture, Oracle DB Diff, and Oracle TopSessions.

Audience
This guide is written for the Oracle Standard Management Pack users who want to
monitor and diagnose problems, tune high impact indexes, and track and compare
changes in their Oracle environment.
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How This Guide Is Organized
This guide is organized as follows:

Chapter 1, "Overview"

Provides a general description of the Oracle Standard Management Pack.

Chapter 2, "Post-Installation Configuration"

Describes how to configure Performance Manager and TopSessions.

Chapter 3, "Introduction to Oracle Performance Manager"

Provides an overview of the Oracle Performance Manager application and its
features.

Chapter 4, "Introduction to Oracle Index Tuning Wizard"

Provides an overview of the Oracle Index Tuning wizard.

Chapter 5, "Overview of the Change Management Applications"

Provides an overview of the Baseline Viewer, DB Capture,  DB Diff, and Change
Manager applications and their features.

Chapter 6, "Using Change Manager"

Provides an overview of the Change Manager application.

Chapter 7, "Using Oracle TopSessions"

Provides an overview of the Oracle TopSessions application and its features.

Appendix A, "Troubleshooting Appendix"

Provides solutions to problems you may encounter while working with the
Standard Management Pack.

Conventions Used in This Guide
The following table  lists the conventions used in the guide.

Convention Explanation

# The default superuser prompt.

% The default user prompt.

[Ctrl/C] Press the Ctrl key while you simultaneously press another key
(in this case, C).



xiii

This guide also assumes that you are familiar with the operation of Microsoft
Windows NT. Refer to the Windows documentation for your system, if necessary. In
general, this guide shows the directory names as they are used in UNIX; on an NT
system, delineate directory names with a backslash (\).

To reduce wordiness and redundancy, menu and submenu choices are joined by
arrows. For example, Collection=>Create refers to the Create Collection choice in
the Collection menu.

Oracle Enterprise Manager Pack Information
The Oracle Enterprise Manager product family includes the following packs: Oracle
Change Management Pack, Oracle Diagnostics Pack, Oracle Standard Management
Pack, Oracle Tuning Pack, Oracle Management Pack for SAP R/3, and Oracle
Management Pack for Oracle Applications. Each pack is fully integrated into the
Oracle Enterprise Manager Console framework.

Oracle Change Management Pack

■ Includes Baseline Viewer, Change Manager, DB Alter, DB Capture, DB Diff, DB
Propagate, DB Quick Change, DB Search, and Plan Editor.

■ Tracks metadata changes in databases.

■ Eliminates errors and loss of data when upgrading databases to support new
applications.

■ Analyzes the impact and complex dependencies associated with application
change and automatically performs database upgrades.

■ Allows you to find the database objects that match a set of search criteria that
you specify.

italics Italicized words indicate variables, such as a file or directory
name.

$ORACLE_HOME Represents the directory where you installed Oracle Enterprise
Manager components and the Oracle Standard Management
Pack applications.  The directory name may be different on your
system.

otracexx The xx represents the version of the database for which you are
collecting data; for example, otrace73 for the Oracle Server
release 7.3.

Convention Explanation
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■ Initiates change safely with easy-to-use wizards that teach the systematic steps
necessary to upgrade.

Oracle Diagnostics Pack

■ Includes Oracle Performance Manager, Oracle Capacity Planner, Oracle Trace,
Oracle TopSessions, and Oracle Event Tests that are provided with the Oracle
Diagnostics Pack.

■ Monitors, diagnoses, and maintains the health of databases, operating systems,
and applications.  Both historical and real-time analysis are used to
automatically avoid problems before they occur.

■ Provides powerful capacity planning features that enable users to easily plan
and track future system resource requirements.

Oracle Standard Management Pack

■ Includes Baseline Viewer, Change Manager, DB Capture, DB Diff, Oracle Index
Tuning Wizard, Oracle Performance Manager, and Oracle TopSessions.

■ Monitors and diagnoses problems, tunes high impact indexes, and tracks and
compares changes in your Oracle environment.

Oracle Tuning Pack

■ Includes Oracle Auto-Analyze, Oracle SQL Analyze, Oracle Expert, Oracle
Index Tuning Wizard, Oracle Tablespace Map, and Oracle Reorg Wizard.

■ Optimizes system performance by identifying and tuning major database and
application bottlenecks such as inefficient SQL, poor data structures, and
improper use of system resources.

■ Proactively discovers tuning opportunities and automatically generates the
analysis and required changes to tune the system.  Inherent in the product are
powerful teaching tools which train DBAs how to tune as they work.

■ Instills "Consultant Quality" tuning expertise into developers and DBAs and
increases their productivity.

Oracle Management Pack for SAP R/3

■ Includes Oracle Performance Manager, Oracle Capacity Planner, and Oracle
Event Tests that are specific to monitoring your SAP R/3 environment.

■ Monitors, diagnoses, and maintains the health of a SAP R/3 system. Both
historical and real-time analysis are used to automatically avoid problems
before they occur.
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■ Provides powerful capacity planning features that enable users to easily plan
and track future system resource requirements.

Oracle Management Pack for Oracle Applications

■ Includes Oracle Performance Manager, Oracle Capacity Planner, Concurrent
Processing Tuning Assistant, and Oracle Applications Event Tests.

■ Enables you to monitor all aspects of your system, including databases and
concurrent managers.

■ Enables the monitoring, diagnosing, and capacity planning of the Oracle
Applications environment.

Oracle Enterprise Manager Documentation
The Getting Started with the Oracle Standard Management Pack manual is one of
several Oracle Enterprise Manager documents.

Oracle Enterprise Manager base documentation

■ The Oracle Enterprise Manager Readme provides important notes regarding the
online documentation, updates to the software, and other late-breaking
information.

■ The Oracle Enterprise Manager Administrator’s Guide explains how to use Oracle
Enterprise Manager, Oracle’s systems management console, common services,
and integrated platform tool.

■ The Oracle Enterprise Manager Concepts Guide provides an overview of the
Oracle Enterprise Manager.

■ The Oracle Enterprise Manager Configuration Guide explains how to configure
Oracle Enterprise Manager.

■ The Oracle Enterprise Manager Messages Manual describes the Oracle Enterprise
Manager error messages and methods for diagnosing the messages.

■ Oracle Intelligent Agent User’s Guide provides configuration information and
answers to crucial troubleshooting questions pertaining to the Oracle Intelligent
Agent.

Oracle Change Management Pack documentation

■ The Oracle Change Management Pack Readme provides important notes regarding
the Oracle Change Management Pack online documentation, updates to the
software, and other late-breaking information.
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■ The Oracle Enterprise Manager Getting Started with Oracle Change Management
Pack manual provides an overview of the concepts and features of the Oracle
Change Management Pack applications.

Oracle Diagnostics Pack documentation

■ The Oracle Diagnostics Pack Readme provides important notes regarding the
Oracle Diagnostics Pack online documentation, updates to the software, and
other late-breaking information.

■ The Getting Started with the Oracle Diagnostics Pack provides an overview of the
concepts and features of the Oracle Performance Manager, Oracle Capacity
Planner, and Oracle TopSessions applications. It also describes the Oracle Event
Tests that are provided with the Oracle Diagnostics Pack, which allow you to
manage database, listener, and service types.

■ The Oracle Enterprise Manager Oracle Trace User’s Guide explains how to use the
Oracle Trace application to capture and use historical data to monitor Oracle
databases.

Oracle Standard Management Pack documentation

■ The Oracle Standard Management Pack Readme provides important notes
regarding the Oracle Standard Management Pack online documentation,
updates to the software, and other late-breaking information.

■ The Getting Started with the Oracle Standard Management Pack provides an
overview of the concepts and features of Baseline Viewer, Change Manager, DB
Capture, DB Diff, Oracle Index Tuning Wizard, Oracle Performance Manager,
and Oracle TopSessions.

Oracle Tuning Pack documentation

■ The Oracle Tuning Pack Readme provides important notes regarding the Oracle
Tuning Pack online documentation, updates to the software, and other
late-breaking information.

■ Oracle Enterprise Manager Database Tuning with the Oracle Tuning Pack provides
an overview of the concepts and features of each of the applications included in
the Oracle Tuning Pack. The applications include Oracle SQL Analyze, Oracle
Expert, Oracle Index Tuning Wizard, Oracle Reorg Wizard, and the Oracle
Tablespace Map. A description of how these applications can work together to
tune an Oracle database is also provided.
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Oracle Management Pack for SAP/R3 Documentation

■ Oracle Management Pack for SAP/R3 Readme provides important notes regarding
Oracle Management Pack for SAP R/3 online documentation, updates to the
software, and other late-breaking information.

■ Oracle Enterprise Manager Getting Started with Oracle Management Pack for SAP/R3
provides an overview of the concepts and features of Oracle Performance
Manager and Oracle Capacity Planner. It also describes Oracle Event Tests that
are provided with the Oracle Management Pack for SAP/R3.

Oracle Management Pack for Oracle Applications Documentation

■ Oracle Management Pack for Oracle Applications Readme provides important notes
regarding Oracle Management Pack for Oracle Applications online
documentation, updates to the software, and other late-breaking information.

■ Getting Started with the Oracle Management Pack for Oracle Applications provides
an overview of the concepts and features of Oracle Performance Manager,
Oracle Capacity Planner, and Concurrent Processing Tuning Assistant. It also
describes Oracle Applications Event Tests and Jobs that are specific to
monitoring your Oracle Applications environment.

■ Oracle Intelligent Agent User’s Guide provides configuration information and
answers to crucial troubleshooting questions pertaining to the Oracle Intelligent
Agent.
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1
Overview

The Oracle Standard Management Pack is an optional set of applications that
provide advanced tools that allow you to monitor and diagnose problems, tune
high impact indexes, and track and compare changes in your Oracle8i environment.

The Oracle Standard Management Pack includes the following applications:

■ Oracle Performance Manager

Applies real-time, graphical Oracle and host monitoring through an extensive
array of customized performance charts.

■ Oracle Index Tuning Wizard

Proactively optimizes the indexes in your database environment.

■ Oracle Baseline Viewer

Lets you display baselines created using DB Capture.

■ Oracle Change Manager

Gives you direct or indirect access to change management operations.

■ Oracle DB Capture

Captures definitions of schema objects.

■  Oracle DB Diff

Allows you to easily compare schemas or databases.

■ Oracle TopSessions

Provides focused, performance diagnostics for Oracle sessions.

The following sections provide an overview of these applications.
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Oracle Performance Manager
Oracle Performance Manager provides a system for capturing, filtering, and
presenting performance data for both the database and the host operating system.
Oracle Performance Manager offers:

■ Graphical, real-time monitoring

With Oracle Performance Manager, database and host operating system
performance statistics are captured in real-time mode and can be viewed in
various tables and charts and in two- and three-dimensional presentations.

■ Predefined charts

Oracle Performance Manager provides a large collection of predefined charts
and tables organized into performance monitoring groups, including database
contention, I/O, load, memory use, instance metrics, parallel server
performance, and host operating system resource usage.

■ User-defined charts

Oracle Performance Manager can be used to graphically display any data
accessible through SQL or through the data collection framework. The
application allows you to create customized charts from user-defined scripts
which then can be added to the Oracle Performance Manager navigator tree for
easy access.

■ Customizable chart attributes and displays

With Oracle Performance Manager, chart properties and attributes can be
customized to change the type of the presentation. The type of chart can be
changed to bar, hierarchical, strip, pie, or table.

■ Chart drill down

Allows charts to be linked to other charts to gather detailed information.

■ Record and playback of charts

A user can capture a chart’s activity for analysis at a later date. Oracle
Performance Manager allows charts to be recorded and played back at your
convenience.

Oracle Index Tuning Wizard
The Oracle Index Tuning wizard quickly finds indexing problems that can slow
down the performance of your Oracle8 database. You can use the Index Tuning
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wizard to evaluate and optimize indexes for situations when, for example, SQL
statement response time is slow.

The Index Tuning wizard considers your application type, for example, data
warehousing, table, and SQL statements for tuning.

The Index Tuning wizard then implements the generated recommendations or
saves the recommendations for later implementation. Each index recommendation
generated contains detailed information on exactly what operation needs to be
performed on the schema.

Oracle Baseline Viewer
The Baseline Viewer application lets you display baselines created using DB
Capture. Baseline Viewer also allows you to view a particular version of a baseline
and to generate SQL statements for a baseline (if the statements were not generated
already by DB Capture when the baseline was created).

Oracle Change Manager
The Change Manager application is the change management central interface. In
most cases, Change Manager gives you direct or indirect access to change
management operations.

Oracle DB Capture
The DB Capture application guides you through the process of capturing the
definitions of a database (or a subset of a database) in a form useful to DB Diff and
other applications. DB Capture lets you specify the set of database object definitions
to capture, then captures those definitions in their current state.

DB Capture can capture object definitions in both of the following forms:

■ A baseline. The baseline stores definitions in a form that DB Diff can use. (A
baseline is an object that contains a set of database definitions captured at a
certain time.)

■ SQL DDL (optional). These SQL DDL statements can be used to create the
definitions in a new database or as input to CASE tools that accept SQL DDL
input.
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Oracle DB Diff
The DB Diff application guides you through the steps of selecting two sets of object
definitions and then comparing them. The object definitions can be selected from
current databases or they can be selected from baselines created earlier with DB
Capture. If differences are found when the two sets of object definitions are
compared, DB Diff allows you to view the differences between the corresponding
object definitions.

Oracle TopSessions
Oracle TopSessions provides a focused view of database activity by database
session. Oracle TopSessions extracts and analyzes sample dynamic Oracle
performance data by session, automatically determining the top Oracle users based
on a specific selection criteria, such as memory, CPU usage, or file I/O activity.

Note: All the applications that make up the Oracle Standard
Management Pack are members of other Oracle Enterprise
Manager Packs. For this reason, you may find mention of other
applications in the help, documentation, and user interfaces that
make up the Oracle Standard Management Pack.
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2
Post-Installation Configuration

After you have installed the Standard Management Pack, configure the components
listed in the following table:

Setting Up Performance Manager
The following setup tasks are required before you use Oracle Performance
Manager:

❏ Configure the Oracle Data Gatherer to collect data

❏ Enable disk statistics collection on Windows NT

❏ Convert any user-defined charts you created with earlier versions of
Performance Manager

The following sections describe each of these setup tasks in more detail.

Configuring Oracle Data Gatherer to Collect Data
Performance Manager requires the use of the data gathering service (also known as
the Oracle Data Gatherer).  For monitoring operating system data, the Oracle Data
Gatherer must be installed on the same node as the operating system you are
monitoring.  For monitoring other service types, such as databases, the Oracle Data
Gatherer can run on the same node as the service you are monitoring, or it can run
on a different node, depending upon your configuration.

Components Where to Find the Information

Performance Manager "Setting Up Performance Manager" on page 2-1

TopSessions "Setting Up TopSessions" on page 2-4
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Refer to the Oracle Intelligent Agent User’s Guide for information on how to configure
and start the Oracle Data Gatherer.

Enabling Disk Statistics Collection for Performance Manager on Windows NT
To collect disk statistics on Windows NT, enable them by typing:

diskperf  -Y

Disk statistics are enabled the next time the system is restarted. For more
information about the DISKPERF tool, refer to the Microsoft Windows NT
documentation.

Converting User-Defined Charts From Previous Releases of Performance Manager
If you created user-defined charts using Performance Manager release 1.5.0 or
earlier and want to use them with the current Performance Manager release,  you
must first convert them to release 1.6.0.

Performance Manager Release 1.6.0 user-defined charts are converted to the current
release when you migrate your existing performance data to the Enterprise
Manager Release 2.1 repository.

For more information, refer to the following sections.

Converting Performance Manager Release 1.5.0 User-Defined Charts
To convert user-defined charts created using Performance Manager Release 1.5.0 or
earlier:

1. Run vmmmig.exe. This executable creates a text file named vtmusr.txt in the
$ORACLE_HOME\SYSMAN\ADMIN directory. This text file contains data
about the user-defined charts created using Performance Manager release 1.5.0
or earlier. When you run vmmmig.exe, specify the user name, password, and

Note: Enabling disk statistics is not required.  You can still
monitor other operating system statistics with Performance
Manager even if disk statistics are not enabled.

Note: Release 1.5.5 of Performance Manager did not include the
functionality of user-defined charts.
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service for the Enterprise Manager repository that contains the user-defined
charts that you want to convert, for example:

vmmmig joseph/password@my_rep

Note that my_rep  in the previous command line is the service name for the
Enterprise Manager repository.

2. Run vmm2vtm.exe. This executable uses the data in the vtmusr.txt file to create
user-defined charts in the repository that can be used with Performance
Manager release 1.6.0. When you run vmm2vtm.exe, supply a user name,
password, and service for the Enterprise Manager V2.x repository and the name
of the service under which you want the user-defined charts stored for
Performance Manager release 1.6.0, for example:

vmm2vtm.exe joseph/password@my_rep my_db

Note that my_rep in the previous command line is the service name of the
Enterprise Manager V2.x repository and my_db is the name of the target service
under which you want the user-defined charts stored. In other words, after the
previous command is run, all the user-defined charts are converted and stored
under the my_db service in the Performance Manager release 1.6.0 tree view.

If any error messages are generated when you run vmm2vtm.exe, edit the
vtmusr.txt file based on the error messages. For example, the error messages
may state that there is a problem with a chart or that a chart does not exist.
Since the vtmusr.txt file contains a list of the charts, edit the file to remove any
problematic charts.

Then, run vmm2vtm.exe again.

Converting Performance Manager Release 1.6.0 User-Defined Charts
If you created user-defined charts with Performance Manager Release 1.6.0, you can
convert those charts for use with the current release of Performance Manager.
User-defined charts created with Performance Manager 1.6.0 are converted when
you create a new Enterprise Manager repository and migrate your existing
performance data to the new repository.

For more information about creating a new Oracle Enterprise Manager repository
and migrating your existing data, see the Oracle Enterprise Manager Configuration
Guide.
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Setting Up TopSessions
To install the features of TopSessions:

❏ Create additional tables and views on each database you want to connect to
from TopSessions

❏ Grant certain SELECT privileges

The smptsixx.sql scripts have been provided to help automate this process. The xx
in the file name identifies the version of the database against which the script
should be run. The script for each database version is located in the $ORACLE_
HOME\SYSMAN\ADMIN directory.

When smptsixx.sql is run, it also automatically runs the following two scripts:

■ catbloxx.sql

■ utlxplxx.sql

These two scripts create in the managed database some additional tables, views,
and public synonyms that are required by the Oracle Advanced Events.

To set up TopSessions for a database:

1. Access SQL*Plus Worksheet from the Start menu by following the path:
Start=>Programs=>ORACLE_HOME=>DBA Management Pack=>SQLPlus
Worksheet.

2. Use the Oracle Enterprise Manager Login dialog box to connect to the managed
database as SYS.

For additional information, refer to the online help or the Oracle Enterprise
Manager Administrator’s Guide.

Version of the Database Script to Run

Oracle 7.3.4 smptsi73.sql script

Oracle 8.0 smptsi80.sql script

Oracle 8.1 smptsi81.sql script

Note: ORACLE_HOME represents the Oracle home in which the
Diagnostics Pack is installed.
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3. Grant SELECT ANY TABLE privileges to each administrator account. This step
may be omitted if the account has already been granted the same privileges as
SYSTEM.

Note that when preparing to run the smptsixx.sql script on managed databases,
you should log into each database as SYS, as mentioned previously.

You can use Security Manager to grant privileges to an account. Refer to the
Oracle Enterprise Manager Online Help for detailed information about how to
use Security Manager.

4. Run the smptsixx.sql script for the managed database.

If the smptsixx.sql script is not run on a managed database, you may see a
"Table or View does not exist" message when you try to use TopSessions.

5. If the ALL_CATALOG view does not exist on the managed database, run the
catalog.sql script on the database from the SYS account. The catalog.sql script is
located in the $ORACLE_HOME\RDBMSxx\ADMIN directory.

6. If the AUDIT_ACTIONS view does not exist on the managed database, run the
cataudit.sql script on the database from the SYS account. The cataudit.sql script
is located in the $ORACLE_HOME\RDBMSxx\ADMIN directory.

7. Exit SQL*Plus Worksheet.
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3
Introduction to Oracle Performance

Manager

Oracle Performance Manager is an Oracle Enterprise Manager application that
allows you to monitor different types of real-time performance data.

Oracle Performance Manager uses the Agent data gathering service (also called the
Oracle Data Gatherer) to collect performance data. To monitor some types of data,
you must install the Oracle Data Gatherer on the system (or systems) where you
want to monitor data. See the Oracle Intelligent Agent User’s Guide for information on
managing the Agent data gathering service on a system.

If you are using Oracle Performance Manager to monitor database performance, the
Agent data gathering service can be installed on another system. See "Accessing
Performance Data Through an Intermediate Host" on page 3-2 for more information
on accessing data through an Agent data gathering service on another system.

The types of performance data that Oracle Performance Manager can monitor on a
system depends on the products that are installed. Table 3–1 shows the types of
data (or services) that Oracle Performance Manager can monitor when various
Oracle products are installed.

Table 3–1 Data that Performance Manager Can Monitor when Various Oracle Products
Are Installed

Oracle
Product

Oracle
Concurrent
Manager Data

Oracle
Server
Data

Operating
System Data

SAP R/3
System
Data

Microsoft
SQL
Server
Data

Diagnostics
Pack

Yes Yes Yes
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If additional products from Oracle or other vendors are installed, Oracle
Performance Manager may be able to monitor additional types of data not shown in
Table 3–1.

Accessing Performance Data Through an Intermediate Host
Oracle Performance Manager relies on the Oracle Data Gatherer to monitor a
service (such as a node, a database, or a concurrent manager). Usually, the collection
of the data is done on the system where the service is located. However, for some
types of services Oracle Performance Manager can also monitor data on a system by
using the Oracle Data Gatherer on another system (an intermediate host).

This intermediate host could be the client system where the Oracle Performance
Manager is running, or any other system on the network on which the Data
Gatherer is available.

There are three ways to set the location of the Oracle Data Gather.  The method you
use depends on how you connect to the service.  Consider the following three
scenarios:

■ You connect to a database that has been discovered using the Enterprise
Manager console and you are running Oracle Performance Manager while
connected to the Oracle Management Server.

Management
Pack for
Oracle
Applications

Yes Yes

Management
Pack for SAP
R/3

Yes Yes

Standard
Management
Pack (Oracle
Standard
Edition only)

Yes Yes Yes

Table 3–1 Data that Performance Manager Can Monitor when Various Oracle Products
Are Installed (Cont.)

Oracle
Product

Oracle
Concurrent
Manager Data

Oracle
Server
Data

Operating
System Data

SAP R/3
System
Data

Microsoft
SQL
Server
Data
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Performance Manager attempts to connect to the Data Gatherer on the host
where the service is located. If this connection fails or cannot be attempted
because no preferred credentials have been set for the database, you will be
prompted with a dialog box containing logon credentials for the database. This
dialog box also contains a field to specify the location of the Oracle Data
Gatherer that will be used to collect performance data.

■ You click the Add New Service button in the toolbar panel and manually add
the service to the navigator.

Performance Manager displays a Logon dialog box.  This dialog box also
contains a field to specify the location of the Data Gatherer that will be used to
collect performance data.

■ You select a service in the Performance Manager navigator tree and choose Set
Data Gatherer Location from the File menu.

Performance Manager displays the Database Logon dialog box for the selected
service. This dialog box also contains a field to specify the location of the Data
Gatherer that will be used to collect performance data.

Usage Scenarios for Oracle Performance Manager
Using Oracle Performance Manager, you can:

■ Monitor one or more services concurrently.

■ View the monitored data in various chart formats, including strip (line), pie,
bar, table, and hierarchical.

■ Set the refresh rate for a chart’s data.

■ View multiple charts concurrently for each monitored service.

■ View multiple charts in a single window.

■ Drill down from one chart to another related chart.

■ Choose the collected data and data sources to display in a chart.

Note: The database name (or service) shown in the Database
Logon dialog box must be a service name which can be resolved on
the system where the Agent data gathering service is located. A
tnsnames entry or name server entry must be available for that
service on the system specified in the Data Gatherer Location field.
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■ Print a chart.

■ Generate an HTML report for a chart.

■ Display context-sensitive help for a chart, if help is available for the chart.

■ Play a recording of a chart, with fast-forward and pause features.

■ Create and modify user-defined charts.

Starting Oracle Performance Manager
You can start Oracle Performance Manager from the Oracle Enterprise Manager
console or from the Start menu.

Starting Oracle Performance Manager from the Console
You can start Oracle Performance Manager from the Oracle Enterprise Manager
console in any of the following ways:

■ On the Oracle Enterprise Manager console, point to the Standard Management
Pack drawer, then click Performance Manager.

■ On the Tools menu of the Oracle Enterprise Manager console, point to Standard
Management Pack, then click Performance Manager.

Starting Oracle Performance Manager from the Start Menu
On the Start menu, follow the path: Start=>Programs=>ORACLE_
HOME=>Standard Management Pack=>Performance Manager.

When you start Performance Manager from the Start menu, you are given a choice
of logging in to the Oracle Management Server or running Performance Manager in
standalone mode.

Note: When you start Oracle Performance Manager from the
Oracle Enterprise Manager console, Oracle Performance Manager
connects to the Oracle Management Server using the same
credentials used to start the Oracle Enterprise Manager console.

Note: ORACLE_HOME represents the home directory in which
the Standard Management Pack is installed.
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Running Performance Manager in Repository Mode
To run Oracle Performance Manager in repository mode:

1. Click Login to the Oracle Management Server.

2. Enter the appropriate connection information for your Oracle Management
Server.

To select an alternate Management Server, click the Management Server button
next to the Management Server drop-down list.  In the resulting dialog box,
you can add another node that is running Oracle Management Server software.
The Oracle Management Server and its associated repository must already exist.

For information on the fields in the Management Servers dialog box, click Help.

3. Click OK.

If the repository information for the Standard Management Pack has not been
created, Oracle Performance Manager automatically updates the repository at
connection time.

Running Performance Manager in Standalone Mode
To run Oracle Performance Manager in standalone mode (not connected to the
Oracle Enterprise Manager repository), click Standalone, no repository connection,
then click OK.

Note: If the repository was created using Enterprise Manager
Release 2.0.4 or earlier, you must upgrade the repository or create a
new repository.  For more information, see the Oracle Enterprise
Manager Configuration Guide.

Note: When you run Oracle Performance Manager without
connecting to a valid repository, you cannot save any user-defined
charts, and any recordings you make during the session will not be
saved when you exit Oracle Performance Manager.

In addition, you will need to manually add services you want to
monitor, and you will have to add them again each time you start
Performance Manager.
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Using the Oracle Performance Manager Main Window
The primary component of the Oracle Performance Manager user interface is the
main window (see Figure 3–1), which contains two panels. The navigator or tree
panel appears on the left side of the main window and the property sheet panel
appears on the right side. When you select an item in the navigator panel, the
property sheet panel displays the properties of the selected item.

When you first start Oracle Performance Manager, the navigator panel displays the
service type folders and the property sheet panel displays the Performance
Manager welcome screen.

A vertical toolbar appears on the left side of the window and a menu bar appears
across the top of the window. For more information about the buttons in the toolbar
and the commands available from the Performance Manager menus, choose
Window from the Performance Manager Help menu.

In the navigator panel, the Network folder contains a folder for each service type.
For example, when you have the Standard Management Pack installed, the service
types are Nodes, Databases, and SQL Servers.

In addition to the Network folders, the Recordings folder contains any recordings
of chart data that exist. For more information about the Recordings folder, see
"Recording Chart Data"  on page 3-17.
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Figure 3–1 Oracle Performance Manager Main Window

Connecting to a Discovered Service in Repository Mode
If you are working in repository mode, expand a service type folder to view the
corresponding services previously discovered through the Oracle Enterprise
Manager console.

To connect to a discovered service, select the service in the navigator tree and click
Connect to Service in the Performance Manager toolbar, or click the plus sign (+)
next to the service in the navigator. You may be prompted with a Logon dialog box
if credentials are required to connect to the service. For information on the fields in
the Logon dialog box, click Help.

Manually Connecting to a Service
If you are working in standalone mode, the service type folders are empty and you
must manually add each service you want to monitor to the navigator tree.
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If you are working in repository mode, you can manually add additional services
that have not been discovered using the Enterprise Manager console.

To add and connect to a service manually:

1. Select the folder for the service type you are adding.

2. Click Add New Service in the Performance Manager toolbar panel.

Performance Manager displays a Logon dialog box.

3. Fill in the fields in the Logon dialog box and click OK.

For information on the fields in the Logon dialog box, click Help.

After you connect to a service, Performance Manager displays the classes of
performance information you can monitor for the selected service. Expand a class to
see the individual performance data charts available for the selected class.

Viewing Performance Manager Charts
You can display a chart using one of the following methods:

■ Select the chart in the navigator, and click the Show Chart button on the
toolbar.

■ Select the chart in the navigator, and choose Show Chart from the Chart menu.

■ Select the chart in the navigator, which displays the chart’s property sheet. To
start the chart with the selected property sheet options, click Show Chart on the
property sheet.

■ Select a chart class, then select the chart in the Predefined Displays list and
click Show Chart.

■ Select the chart in the navigator and click the right mouse button.  From the
context menu, click Show Chart.

Performance Manager displays each chart or chart group in its own window, which
is separate from the main window. This window is called the Chart Display

Note: When you add a service manually to the navigator tree
using the Add New Service button, you are adding that service for
the current session of Performance Manager only.  You can begin
collecting data for the service, but if you exit and restart
Performance Manager, you will have to add the service again.
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window.  For more information, see "Using the Chart Display Window"  on
page 3-11.

Monitoring Multiple Services Concurrently
You can view charts from multiple services concurrently by connecting to the
services from the navigator tree and displaying the chart.

Viewing Chart Groups
Some types of data include a chart group, which is two or more charts that are
displayed within a single Chart Display window. You display a chart group the
same way as you view any other chart (see "Viewing Performance Manager Charts"
on page 3-8).

You can display a special chart group that contains the Overview Charts for a
selected service:

1. Select a service in the Performance Manager navigator.

2. Click the Show Overview Charts button in the toolbar panel.

Performance Manager displays a chart group containing some key statistics
most likely of interest to database administrators monitoring the selected
service.

Charts in a chart group are displayed within a single window. You perform actions,
such as setting options and displaying drill-down charts, on one chart at a time
within a chart group. The currently selected chart within a chart group window is
identified by a highlighted title.  For example, the Memory Faults chart is the
currently selected chart in Figure 3–2.
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Figure 3–2 Identifying the Selected Chart In a Chart Group

Besides viewing the Overview Charts for a selected service, you can also view a
chart group provided with a data class.  For example, you can select the Memory
data class for a Windows NT node and display the Memory at a Glance chart
group. Not all data classes provide chart groups, however.

Selecting Collected Data and Data Sources
For some charts, the chart’s property sheet allows you to select the collected data to
display and the data sources for which the collected data should be displayed.

The collected data are the statistics that can be monitored and displayed in the
chart. The data sources are the items from which Oracle Performance Manager is
able to collect the data. For example, the data source of disk statistics may be disk1
or disk2, and the data source of file statistics may be file1 or file2.

By clicking in the column next to the name of the collected data or the name of the
data source in the chart property sheet, you can specify whether or not to monitor
that collected data or data source and display it in the chart.

When a green check mark appears in the column, Oracle Performance Manager will
display that collected data or data source in the chart. If you click in the column
again, the check mark goes away, which indicates that Oracle Performance Manager
will not display that collected data or data source. You can toggle back and forth
between monitoring and not monitoring all the collected data or data sources by
clicking in the column head. If the check mark is gray, it means Oracle Performance
Manager will display the collected data or data source, and you are unable to
change the selection of this data.

If the chart definition contains default data source or collected data attributes, then
those items are preselected in the chart’s property sheet.
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Using the Chart Display Window
When you display a chart, Oracle Performance Manager opens the Chart Display
window.  The window contains its own toolbar and menu bar. For information
about the Chart Display window, choose Window from the Chart Display window
Help menu.

Selecting a Chart Format
To change the format of the chart, click one of the chart format buttons in the Chart
Display window toolbar.

For example, suppose a chart initially displays as a bar chart.  To see the data as a
pie chart, click the Pie Chart button in the toolbar.  You can also display a chart in
one of the additional formats:

■ Bar

■ Strip (or line chart)

■ Table

■ Hierarchical

For more information about the buttons on the Chart Display window toolbar, see
the Oracle Performance Manager online help.

Setting the Chart Refresh Rate
By default, most charts are set to refresh every five seconds.  That means that
Performance Manager collects the data every five seconds and then immediately
refreshes (or redisplays) the chart using the new data.

To change the refresh rate for the current chart:

1. Click the Set Refresh rate button in the Chart Display window toolbar.

Performance Manager displays the Set Refresh Rate dialog box.

2. Use the fields on the dialog box to set a new refresh rate for the current chart.

3. Click OK to close the dialog box and display the chart using the new refresh
rate.

Note: Depending upon the type of chart you are displaying, one
or more of the chart formats may not be available.
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Pausing and Restarting a Chart
By default, Performance Manager continues to collect performance data and update
the current chart using the current refresh rate.

To pause a chart so it stops redisplaying based on the refresh rate, click the Pause
Chart button in the Chart Display toolbar.

To restart the chart, click the Resume Chart button in the Chart Display toolbar.

Selecting Chart Options
After you display a chart in the Chart Display window, you can still modify the
collected data and data sources for the chart.  For more information about selecting
the collected data and data sources before you display a chart, see "Selecting
Collected Data and Data Sources" on page 3-10.

To set the chart options:

1. Click the Set Options button in the Chart Display toolbar.

Performance Manager displays the Set Options dialog box.

2. Use the dialog box to add or remove data items from the chart.

For more information on selecting data sources and selecting collected data,
click Help.

Oracle Performance Manager also allows you to select filters to limit the data
collected for a chart. However, not all charts provide filters.

For charts that allow you to filter the chart data, you can select a limit to the number
of data sources that are displayed. For example, if the data sources are the processes
on an operating system, you can modify the chart to display only 10 processes,
rather than all the processes.
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For example, to select a limit to the number of data sources that are displayed for
the Pagefaults Per Session chart, do the following:

1. Highlight the Pagefaults Per Session chart in the navigator tree of the
Performance Manager main window.

You can locate the chart by traversing the tree as follows:
Network=>Nodes=><Name of Node>=>Process=>Pagefaults Per Process.

2. Click the Options tab in the Property Sheet panel.

3. Enter 10 in the Maximum Number of Data Sources to Display field.

The 10 data sources will be sorted by Page Faults per second, as shown in the
Sort the data by drop-down list.

4. Click Show Chart.

Performance Manager displays the chart, but includes a maximum of 10 data
sources.

You can later change this setting after the chart is displayed:

1. In the Chart Display window for the Pagefaults Per Process chart, click the Set
Options button in the toolbar.

2. In the Options tab, set the Maximum Number of Data Sources to Display back
to 7.

3. Click OK.

These options can be useful for finding the top resource users. In the case where
processes are the data sources and the data collected is memory usage and CPU
usage, you can ask the Agent data gathering service to limit the number of data

Note: The Pagefaults Per Session chart in the Process class is
available only when you are monitoring a Windows NT node. For a
UNIX node, select the Process Info chart in the Process Data class
as an example of a chart you can filter.

Note: The number of options available on the Options tab will
vary, depending upon the class of data you are modifying. Some
data classes offer more or fewer options than the Pagefaults Per
Process class discussed here.
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sources to 10, and to sort by memory usage. Your chart would then show the 10
processes using the most memory. If you were to sort by CPU usage, you would get
the 10 processes using the most CPU instead.

Some charts can also give different views of the data. If that feature is available, you
will also be able to select a view of the data. An example of a data view may be the
current rate per second or current rate per transaction for each piece of data
collected in the chart.

Chart-Specific Commands
Some types of charts have their own unique commands. For example, you can select
the Kill Session command when you are viewing the Lock Manager charts for
Oracle database services.

To see if a chart-specific command is available for a chart:

■ Click the right mouse button on an item name in the chart legend or a data item
in the chart and click Tools on the context menu.

■ Click the Tools menu on the Chart Display window menu bar.

Drilling Down from One Chart to Another
Some charts have drill-down charts associated with them. To see if any drill-down
charts are available for the current chart, do one of the following:

■ Click the right mouse button on an item name in the chart legend or a data item
in the chart and click Drilldown on the context menu.

■ Click the Drilldown menu on the Chart Display window menu bar.

In either case, Performance Manager displays any drill-down charts associated with
that chart item as menu options on the Drilldown menu. If a list of drill-down chart
names is not displayed, it means no drill-down charts are associated with that item.

Displaying Alternate Chart Orientations
You can display bar charts with either a horizontal or vertical orientation.

Note: If you have trouble selecting a particular data item when
you try to drill down for related data, pause the chart or reduce the
refresh rate. For more information, see "Pausing and Restarting a
Chart" on page 3-12.
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To change the orientation of the bar chart, click the button associated with the
orientation that you want.

Sorting Data in a Table Chart
When a chart is displaying data in table format, the sort order of the column data
can be changed by clicking the column headers in the table. The first click on a
column header sorts the data in ascending order, and a second click sorts the data in
descending order.

Changing the sort order in the chart table does not affect the data’s sort order on the
server. To change the sort order of the data on the server, use the Options page. For
more information, see "Selecting Chart Options" on page 3-12.

Saving Your Changes to a Chart
If you are working in repository mode and you make modifications to a chart (for
example, if you change the format, orientation, or sorting order of a chart), you can
save your changes in one of two ways:

■ Click Save on the Chart Display File menu.

Performance Manager saves your changes using the same name as the original
chart. When you display the chart again, your changes will appear in the Chart
Display window.

To later remove your changes and display the predefined chart using its
original settings, click Remove Chart on the Chart menu.

■ Click Save As on the Chart Display File menu.

Performance Manager displays the Save Custom Chart dialog box. Use this
dialog box to enter a name for the custom chart and to indicate whether you
want to create a similar chart for other services of the same type.  For
information about the fields on the Save Custom Chart dialog box, click Help.

Click OK in the Save Custom Chart dialog box to save the custom chart using
the name you provided.  Performance Manager saves the chart in the Custom
Charts folder for the selected service.

Note: You can remove the changes you saved to a predefined
chart, but you cannot delete the original predefined chart.
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To delete a custom chart from the Custom Charts folder, select the chart and
click Remove Chart on the Chart menu.

Obtaining Help for a Class, Chart, or Data Item
To get help on a class or chart:

1. Select the class or chart.

2. From the Help menu,  choose Selected Item.

If help is available for the selected chart, Performance Manager displays a
message box or a help topic window describing the chart data.

To get help on a data item:

1. Select a chart.

2. In the Property Sheet panel, hover over a data item or select a data item and
choose Selected Item from the Help menu.

If help is available for the selected item, Performance Manager displays a
pop-up balloon or a message box describing the data item.

Printing a Chart
To print a chart, click the Print Screen button on the Display Chart window toolbar.

The size of the chart on the screen determines the size of the chart in the chart
printout. For example, when you print a chart that is 5 inches high and 7 inches
wide on your screen, the chart will be 5 inches high and 7 inches wide in the
printout.

Generating a Report for a Chart
To generate an HTML report for a chart:

1. Click the Report Chart button while the chart is displayed.

Note: You can delete custom charts, but you cannot delete
predefined charts.

Note: Help is not available for all objects.
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Performance Manager displays a dialog box that tells you the name of the
HTML file used to display the report and where the file will be saved.

2. Make a note of the file name and location.

3. Click Yes to preview the chart in your Web browser, or click No if you do not
want to preview the report.

You can view the report later using a Web browser, or—if you have experience with
Web publishing tools and techniques—you can share the report with your
co-workers by publishing the HTML file and its associated graphic files on a Web
server.

Recording Chart Data
Oracle Performance Manager allows you to record the data being monitored in a
chart. After a recording is complete, you can play it back. During playback, you can
pause and fast forward the recording, if you wish.

Chart recordings are saved under the Recordings folder and on the Recordings tab
of the right pane of the Performance Manager main window when a recorded chart
is selected. The Recordings tab is added to a chart’s property sheet after you record
the chart.

You can manage chart recordings in the Recordings folder without connecting to
the service from which a chart was recorded. If you are already connected to a
service, you can see a chart’s recordings by selecting the Recordings tab in that
chart’s Detail property sheet.

Starting a Recording
You start a recording by performing one of the following steps:

■ With a chart highlighted in the navigator tree of the Performance Manager main
window, click Record Chart on the chart’s property sheet.

■ With a chart displayed in the Chart Display window, click Start Recording in
the Chart Display window toolbar.

■ With a chart displayed in the Chart Display window, click
File=>Recording=>Start Recording.

Oracle Performance Manager displays the Recording Parameters dialog box.  For
more information on the fields in the Recording Parameters dialog box, click Help.
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Stopping a Recording
To stop recording a chart, do one of the following:

■ To stop recording the current chart, click the Stop Recording button in the
Chart Display window toolbar.

■ To stop all recordings at one time, choose Stop All Recordings from the
Performance Manager main window Recordings menu.

■ To stop a recording from the Recordings folder, expand the Recordings folder
in the Performance Manager main window and navigate to the chart. Select the
chart and click Stop Recording on the chart’s property sheet.

■ With a chart displayed in the Chart Display window, click
File=>Recording=>Stop Recording.

Playing a Recording

To play a recording, do the following in the Performance Manager main window:

1. Navigate to the Recordings folder.

2. Select the chart you want to play in the navigator tree.

3. In the corresponding property sheet, select the recording from the list of
recordings for the selected chart, and click Play Recording (or on the
Recordings menu click Play Recording).

4. In the Chart Display window toolbar, click Start Playback.

The Stop Playback, Pause Playback, and Fast Forward buttons become
available in the playback window (Figure 3–3). When the playback is complete,
the Reset Playback button becomes available.

Figure 3–3 Chart Playback Buttons in the Chart Display Window

Note: Before you can play a recording, you must stop the
recording.  For more information, see "Stopping a Recording" on
page 3-18.
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Removing a Recording
To remove a recording:

1. Navigate to the Recordings folder or the Recordings tab on the chart’s Detail
page.

2. Select the recording you want to remove.

3. From the Recordings menu, click Remove Recording.

Creating a User-Defined Chart
In addition to predefined charts, you can define your own charts for database
services based on user-defined scripts. By defining your own charts, you can take a
snapshot of data at any given interval. After successful evaluation of the script, you
can define the operations to be performed on the data.

To define a new chart:

1. Expand the Databases folder in the navigator tree.

2. Expand the database for which you want to define a user-defined chart.

3. Select the User-Defined Charts folder.

4. Click Add User-Defined Chart in the toolbar.

The resulting New Chart property sheet includes the SQL Script Command
page and the Data Items page.

5. On the SQL Script Command page, enter a SQL script that will be used to
gather statistics for the chart you are defining.

6. Click Evaluate.

Performance Manager evaluates the SQL script. If the script is valid,
Performance Manager displays the Data Items page.

7. Use the Data Items page to customize how the resulting data from the script
entered on the SQL Script Command page will be displayed in chart form.

Note: The Performance Manager online help includes an example
of creating a user-defined chart. Search for Example in the online
help index.
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You can remove columns and change the names of the columns. You can also
define new columns with data calculated from existing columns. For more
information, see "Modifying the Data Items for a User-Defined Chart" on
page 3-20.

Modifying an Existing User-Defined Chart
To modify an existing chart you perform the same steps as outlined in "Creating a
User-Defined Chart" on page 3-19. The only exception is that the chart label is
already defined.

To modify an existing chart:

1. Expand the Databases folder in the navigator tree.

2. Expand the database for which you want to modify a user-defined chart.

3. Select the User-Defined Charts folder.

4. Click the name of the chart you want to modify.

On the SQL Script Command page, you can modify the script used to gather
statistics for the chart. On the Data Items page, you can remove, add, or modify
the data items associated with the chart. For more information, see "Modifying
the Data Items for a User-Defined Chart" on page 3-20.

Modifying the Data Items for a User-Defined Chart
When you select a user-defined chart and then display the Data Items page, you can
modify the data items for the chart as follows:

■ Select a data item and click Set Data Source.

A key icon appears next to the data item you designate as the data source.  The
data source is the object about which Performance Manager is able to collect the
data. You must designate one of the data items as the source for the
user-defined chart. To designate a data item as the data source, highlight the
data item you want as the data source and click this button. By default, the first
data item is set as the data source.

Note: To add or modify data items to user-defined charts, you
must use the Agent data gathering service release 8.1.6. or later.
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■ Select a data item and click Remove.

Performance Manager removes the data item from the Data Items page.

■ Select a data item and click Modify or click Add to add a new data item to the
user-defined chart.

Performance Manager displays the Add/Modify Chart Columns dialog box. For
more information about this dialog, click Help. The Oracle Performance Manager
Help provides details on the functions and operations available. The Help also
provides an example of creating a user-defined chart.

Copying a User-Defined Chart
You can copy user-defined charts from one service to another or within the same
serve by using the Create Like option. To copy a user-defined chart:

1. In the navigator tree, select the user-defined chart you want to copy.

2. From the Charts menu, click User-Defined Charts=>Create Like.

Performance Manager displays the Create Like User-Defined Chart dialog box.

3. Type a label for the new chart in the Chart Label field.

Note that chart labels must be unique within a service.

4. In the Service drop-down list, select the target service for the new chart.

5. Click OK.

In the Create Like User-Defined Chart dialog box, you can choose the SQL Script
Command or Data Items page to view the attributes of the chart you are copying.
However, you cannot change the values of the attributes. Once the chart has been
copied, you can select the new chart in the navigator tree and make any desired
adjustments.

Converting Old Performance Manager User-Defined Charts
If you created user-defined charts using Oracle Performance release 1.5.0 or earlier
(the Windows versions of Oracle Performance Manager), you can convert these

Note: To add or modify data items to user-defined charts, you
must use the Agent data gathering service release 8.1.6 or later.
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user-defined charts so that they can be used with Oracle Performance Manager
release 2.1. See "Converting User-Defined Charts From Previous Releases of
Performance Manager" on page 2-2 for information on how to perform the
conversion.
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4
Introduction to Oracle Index Tuning Wizard

The Oracle Index Tuning wizard is a software application that identifies tables with
inefficient indexes and makes recommendations which will improve access to those
tables.

The Index Tuning wizard:

■ Identifies tables in need of index changes

■ Presents its findings in reports

■ Implements the recommendations for you

The Index Tuning wizard is intended for use with the Oracle cost-based optimizer.
The recommendations made by the Index Tuning wizard will optimize index usage
for the Oracle cost-based optimizer. Therefore, you should not use the Index Tuning
wizard for those schemas where rule-based optimization is used.

This chapter describes when to use the Index Tuning wizard, how to access the
Index Tuning wizard, and the Index Tuning wizard interface.

When to Use the Index Tuning Wizard
You can use the Index Tuning wizard to proactively maintain optimal indexes for
your database. You should run the Index Tuning wizard regularly to evaluate
whether index changes should be made to improve SQL query performance. The
Index Tuning wizard may recommend adding new indexes, changing existing
indexes, or changing the type of an index.

You should also use the Index Tuning wizard when one of the following situations
occurs:

■ A user has reported unacceptable response times for a query



Accessing the Index Tuning Wizard

4-2 Getting Started with the Oracle Standard Management Pack

■ New applications have been added to the database environment

■ Existing application SQL has been modified

■ The database server has been upgraded to a new version

■ Table sizes within the database have increased substantially

Any of these factors may impact the indexing decisions for the database.

Accessing the Index Tuning Wizard
You can access the Index Tuning wizard in the following ways:

■ From the Standard Management Pack tool drawer

■ Through the Oracle Expert application

If you have the Oracle Expert application installed, you can launch the Index
Tuning wizard from the Oracle Expert Tools menu.

The Index Tuning wizard makes two database connections:

1. The Index Tuning wizard connects to its repository to store and analyze data
required for index tuning.

2. The Index Tuning wizard uses the database credentials defined in Oracle
Enterprise Manager console to connect to the target database for index tuning.

Index Tuning Wizard Interface
When you first access the Index Tuning wizard, you are greeted with a Welcome
screen that provides some of the advantages of using the Index Tuning wizard.

You will be lead through the following screens:

■ Application Type

■ Schema Selection

■ Index Recommendations

■ Analysis Report and Script

Note: In either case, you must first select a database in the
navigator tree before launching the Index Tuning wizard.
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■ Finish

Each of these screens is described in the following sections.

Application Type
On this screen, you choose the type of application that is primarily being used for
the target database being tuned: Online Transaction Processing (OLTP), data
warehousing, or multipurpose.

Schema Selection
On this screen, you have the opportunity to select the schemas you wish to
evaluate. The Any Schema option tells the Index Tuning Wizard to select any
schema which has a table referenced by one of the worst performing SQL
statements. Select this option if you want an overview of the database’s overall
performance problems.

The purpose of the Selected Schemas option is to hide recommendations for
schemas that you are not responsible for tuning or you do not wish to tune at the
current time. Select this option if you only want recommendations for schemas you
control. The schemas you select may or may not be the worst performers so you
may or may not get tuning recommendations for all of the selected schemas.

When you first use the Index Tuning wizard, it is best to let the wizard select any
schema so you will see an overall view of the problem areas. You can then focus on
specific areas of the database for which you have control.

Index Recommendations
From this screen you can:

■ Have the Index Tuning wizard generate the index recommendations, that is,
collect and analyze the data to provide the index recommendations.

■ Choose the index recommendations to be implemented.

The Index Tuning wizard provides a work-in-progress dialog box.

You can stop the generation at any time. The Index Tuning wizard deletes all the
created files in preparation for the next generation.

Once the recommendations are generated, use this screen to choose the index
recommendations you want to implement. The Details button provides additional



Index Tuning Wizard Interface

4-4 Getting Started with the Oracle Standard Management Pack

information about each recommendation. To activate the Details button, select a
recommendation.

Analysis Report and Script
The Analysis Report and Script page displays  the Analysis Report and Script tabs
to view all of the recommendations for a tuning session, as well as the rationale for
those recommendations.

During an analysis, the Index Tuning Wizard sifts through the collected data, uses
its rules to generate tuning recommendations, then stores the information for the
Analysis report in the repository. The Analysis report information stays in the
repository until another analysis is performed for the tuning session.

The Script tab displays the SQL script needed to implement the recommendations
that you selected on the Index Recommendations page. You can view the SQL before
choosing to implement the recommended changes.

You can print and save the report and script from this page.

Finish
This screen allows you to implement and save the index tuning recommendations.
The possibilities are:

■ Implement the selected recommendations immediately

■ Save the recommendations as an implementation script (Provides you with
another opportunity to save the analysis report and script if you have not
already done so.)

■ Save the recommendations to an Oracle Expert Tuning Session (Standard
Management Pack users must have the Oracle Tuning Pack installed for this
option to work.)

When you click Finish, the recommendations will be saved and/or implemented
according to the choices made.

Note: The Analysis report for a tuning session is available only
after the Index Tuning Wizard has analyzed the collected data.
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5
Overview of the Change Management

Applications

The change management applications provided by the Oracle Standard
Management Pack are a group of integrated applications used to track changes to
database object definitions.  The change management applications are components
of Oracle Enterprise Manager.

The change management applications provided by the Oracle Standard
Management Pack are:

■ Baseline Viewer

■ DB Capture

■ DB Diff

■ Change Manager

This chapter provides an overview of important change management concepts and
features.

The following section describes new features for this release of the change
management applications.

New Features for the Change Management Applications
The following list describes the major new features for this version of the change
management applications:

■ Change Manager application
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Change Manager, a new application, is now the central control panel for the
change management applications. In most cases, interaction with the change
management applications is directly or indirectly through Change Manager.

■ Improved multiple user support

The change management applications provide improved multiple user support.
Each user has read and write access to the object definitions that he or she
owns, and has read-only access to object definitions owned by other users. The
Change Manager navigator tree displays baselines and comparisons, organized
by owner.

■ Baselines and comparisons can be created from the Oracle Enterprise Manager
console and from DBA Studio

See "Capturing a Baseline from the Oracle Enterprise Manager Console or DBA
Studio" on page 5-7 and "Performing a Comparison from the Oracle Enterprise
Manager Console or DBA Studio" on page 5-9 for more information.

■ History features for change management tasks

You can now view history entries that show the status of the following change
management tasks:

– Capturing baselines

– Performing comparisons

By viewing the history entries for tasks, you can determine when each change
management task was performed and which user performed it. See "Viewing
History Entries for Tasks" on page 6-5 for more information on history entries
for tasks.

■ Launch DBA Studio from Change Manager

You can launch DBA Studio directly from Change Manager to modify database
objects. On the Change Manager Tools menu, click DBA Studio to start DBA
Studio.

■ Create and view multiple versions of a baseline

After you create a named baseline specification that describes the object
definitions to include in the baseline, use the specification as often as you like to
generate baseline versions that match the baseline specification criteria.

Any  differences between versions of a baseline accurately reflect differences in
the database contents, not changes to the baseline specification (a baseline
specification is a read-only object). Storing these baseline versions is an easy
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way to record changes in your database at different times in a development
cycle.

You can view a particular version of a baseline. See "Working With a Particular
Version of a Baseline or Comparison" on page 6-6 for more information on
viewing baseline versions.

■ Create and view multiple versions of a comparison

After you create  a comparison specification that describes the sets of object
definitions to compare, use the specification as often as you like to generate
comparison versions that determine the differences between the sets of object
definitions.

Any differences between comparison versions accurately reflect differences in
the database contents, not changes to the comparison specification (a
comparison specification is a read-only object). Storing these comparison
versions is an easy way to record the differences between two sets of definitions
at different times in a development cycle.

You can view a particular version of a comparison. See "Working With a
Particular Version of a Baseline or Comparison" on page 6-6 for more
information on viewing comparison versions.

■ View text differences for database object definitions

The DB Diff application now lets you view the text differences in the SQL for
objects such as check constraints, procedures, functions, packages, trigger
bodies, and views.

After performing a comparison, select an object pair in the DB Diff tree view
and in the detail view to the right of the tree view, select the text attribute of the
object, then choose Show Text Difference on the Tools menu. This option only
applies to text attributes such as the body of a procedure.

■ Exclude the SYS and SYSTEM schemas from an operation

When you capture a baseline using the Advanced mode of DB Capture, the user
interface now allows you to specify that you want to exclude the SYS and
SYSTEM schemas from the operation.

See the online help for more information.

■ Baseline Viewer application

Use Baseline Viewer, a new application, to view baselines.
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Database Objects Supported by the Change Management Applications
The types of database object definitions that the change management applications
supports are:

■ Cluster

■ Database link

■ Function

■ Index

■ Package

■ Package body

■ Procedure

■ Profile

■ Refresh group

■ Role

■ Rollback segment

■ Sequence

■ Snapshot

■ Snapshot log

■ Synonym

■ Table

■ Tablespace

■ Trigger and instead-of trigger

■ User

■ View

In this release, the change management applications do not support the following
features of the database objects in the previous list:

■ Object-oriented features:

– Tables and snapshot logs that refer to user-defined data types.

– Object tables
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– Nested tables

– Object views

■ Snapshots that are not read-only

For a more complete list that describes the level of support the change management
applications offer for specific database objects and attributes, see the section on
currently unsupported database features and attributes in the Oracle Standard
Management Pack Readme.

Understanding Change Management Objects
The following types of objects are created only by change management applications
and are used to track changes to other object definitions:

■ Baselines

A baseline is a group of database object definitions captured by the DB Capture
application at a particular point in time. Each baseline has the name of its
baseline specification and a version number. A baseline is stored in a format
that can be used by multiple change management applications.

A baseline specification is used to generate baselines. A baseline specification
includes a baseline name, source database, scope specification, and owner. The
baseline name can be changed after the baseline specification is created, but the
source database, scope specification, and owner cannot. The scope specification
for a baseline is a set of criteria that an object must meet to be included in the
baseline generated from the baseline specification. The scope specification
describes the types of database object definitions to be included in the baseline,
the schemas in which to look for those object definitions, and the names of
those object definitions. See "Overview of DB Capture" on page 5-7 for more
information about baselines.

■ Comparisons

A comparison identifies the differences found by the DB Diff application in two
sets of database object definitions. Each comparison has the name of its
comparison specification and a version number.

A comparison specification is used to generate comparisons. A comparison
specification is defined by its name, source database, scope specification, and
owner. The name can be changed after the comparison specification is created,
but the source database, scope specification, and owner cannot. The scope
specification for a comparison is a set of criteria that the set of  objects to be
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compared must meet to be included in a comparison generated from the
comparison specification. The scope specification describes the types of
database object definitions to be included in the comparison, the schemas in
which to look for those object definitions, and the names of those object
definitions. See "Overview of DB Diff" on page 5-8 for more information about
comparisons.

Change Management Applications
With change management applications, you can track changes by:

■ Capturing the current definitions of a set of database objects in a baseline.

■ Creating new versions of a baseline at regular intervals to track changes in that
set of database objects over time.

■ Comparing a set of object definitions in one schema, database, or baseline to
another set of definitions (in a schema, database, or baseline) by performing a
comparison. A comparison finds the differences between the two sets of
definitions.

■ Creating new versions of a comparison at regular intervals to determine the
differences between the two sets of definitions over time.

The applications and their functions are:

– DB Capture

Captures one or more definitions from one database.

– Baseline Viewer

Lets you display baselines created earlier using DB Capture.

– DB Diff

Compares two sets of definitions.

The change management applications also include the Change Manager
application, which is a general-purpose interface that provides direct or indirect
access to all change management features. See "Starting Change Manager" on
page 6-1 for more information on starting Change Manager.

The following sections provide additional overview information on the change
management applications.
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Overview of DB Capture
The DB Capture application guides you through the process of capturing a database
(or a subset of a database) in a form that is readable by other change management
applications.  DB Capture lets you specify the set of database object definitions to
capture, then captures those definitions in their current state at the time of the
capture operation.

DB Capture can capture object definitions in both of the following forms:

■ A baseline.  The baseline stores definitions in a form that other change
management applications can use. A baseline is created during every capture
operation.

■ A SQL DDL script.  The script contains the SQL statements that correspond to
the captured definitions. You can use the script to save a textual version of the
definitions or as input to CASE tools that accept SQL DDL input. You can also
use individual SQL statements from the script to create definitions in a new
database. You have the option of whether or not to create a SQL DDL script.

Figure 5–1 shows the functional capabilities of DB Capture.

Figure 5–1 Functional Capabilities of DB Capture

To view a baseline created with DB Capture, use the Baseline Viewer application.

Capturing a Baseline from the Oracle Enterprise Manager Console or DBA
Studio
When you have Oracle Standard Management Pack installed, you can perform a
capture operation from the Oracle Enterprise Manager console or DBA Studio by
following these steps:

1. Select a database, type, or schema folder in the Oracle Enterprise Manager
navigator or the DBA Studio navigator.

2. Click the right mouse button.

from one databaseone or more
definitions ...

NU-3699A-AI

Captures ...
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3. On the context menu, point to Standard Management, then click Capture
Database Objects.

DB Capture is started to capture a baseline for the selected database, then after the
capture operation is completed, the Baseline Viewer is started to allow you to view
the baseline.

The online help contains more information about the specifics of using DB Capture.

Overview of Baseline Viewer
The Baseline Viewer application lets you display baselines created earlier using DB
Capture.

Figure 5–2 shows the functional capabilities of Baseline Viewer.

Figure 5–2 Functional Capabilities of Baseline Viewer

You can also use Baseline Viewer to generate a SQL DDL script for the baseline if
you did not generate one when the baseline was captured.

The online help contains more information about the specifics of using Baseline
Viewer.

Overview of DB Diff
The DB Diff application guides you through the steps of selecting two sets of object
definitions and then comparing them.  The object definitions can be selected from
current database definitions or they can be selected from baselines created earlier
with DB Capture. If differences are found when the two sets of object definitions are
compared, DB Diff allows you to view the differences between the corresponding
object definitions.

The result of comparing two sets of object definitions using DB Diff is called a
comparison. You can name a comparison, save it, and view it later.

Figure 5–3 on page 5-9 shows the functional capabilities of DB Diff.

NE-0008A-AI

Displays ... a baseline
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Figure 5–3 Functional Capabilities of DB Diff

You can also generate a report in HTML format about a DB Diff comparison.  The
report includes:

■ A description of what you compared.

■ The comparison options you selected.

■ A summary of the comparison results.

■ The comparison tree and comparison details (optional).

Performing a Comparison from the Oracle Enterprise Manager Console or DBA
Studio
When you have the Oracle Standard Management Pack installed, you can perform a
comparison operation from the Oracle Enterprise Manager console or DBA Studio
by following these steps:

1. Select a database, type, or schema folder in the Oracle Enterprise Manager
navigator or the DBA Studio navigator.

2. Click the right mouse button.

3. On the context menu, point to Standard Management, then click Compare
Database Objects.

DB Diff is started to perform a comparison, then the DB Diff viewer is started to
allow you to view the comparison.

The online help contains more information about the specifics of using DB Diff.

Overview of Change Manager
The Change Manager application is the change management central interface.  In
most cases, Change Manager gives you direct or indirect access to change
management operations.

two sets of definitions ...

NU-3700A-AI

Compares ...

from different schemas within
a database or baseline, or from
two databases, two baselines,
or a database and a baseline
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Using Change Manager, you can view change management objects (baselines and
comparisons), as well as check on the status of current tasks. You can also view
history information that tells you which change management operations were
performed by what users at what time.

Figure 5–4 shows the functional capabilities of Change Manager.

Figure 5–4 Functional Capabilities of Change Manager

See Chapter 6, "Using Change Manager" on page 6-1 for more information on using
Change Manager.

Sample Uses for the Change Management Applications
Some of the common usage scenarios for the change management applications are:

■ Using DB Capture to capture a baseline of the current state of database object
definitions, then using DB Diff later to compare the baseline to the current state
of those database definitions.

■ Using DB Capture to create a baseline specification that describes the object
definitions that you want to include in the baseline, then using the specification
multiple times to create new versions of the baseline. The definitions included
in the baseline versions may differ over time, as changes are made at the source
database being used. These baseline versions can be stored by Oracle Standard
Management Pack, making them an easy way to record important points in a
development cycle.

■ Using DB Diff to create a comparison specification that describes the sets of
object definitions that you want to compare, then using the specification
multiple times to create new versions of the comparison. The differences found
during each comparison may change over time, as changes are made to the sets
of definitions being compared. These comparison versions can be stored by DB
Diff, making them an easy way to record changes to sets of definitions at
different points in a development cycle.

direct or indirect access to all
change management features

NU-3705A-AI

Provides ...
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■ Using the history features in Change Manager to track the status of change
management tasks performed by your users.

Using Help
Online help is provided for all of the Oracle Change Management Pack
applications. Note that the Oracle Standard Management Pack includes only the
Change Manager, Baseline Viewer, DB Capture, and DB Diff applications, and
provides read-only access to database object definitions. Also, you cannot create
change plans with Oracle Standard Management Pack. You can display either the
Contents page of the Oracle Change Management Pack help system, or you can
display a help topic for your current context in an application.

Displaying the Contents Page for Help
Depending on the application that you are using, you can display the Contents page
for the Oracle Change Management Pack online help by using one of the following
methods:

■ Press F1. If the Contents page for the help system does not display, click the
Navigator button on the Help Topic Window toolbar.

■ Click the ? on the application toolbar. This applies to Change Manager, Baseline
Viewer, and DB Diff only.

■ On the Help menu, choose Contents. This applies to Change Manager, Baseline
Viewer, and DB Diff only.

Use the help system’s Contents page, Index page, or Help Search page to locate help
topics of interest. To access the Help Search page, on the Help Navigator window’s
Tools menu, choose Search.

Displaying a Help Topic for Your Current Context in an Application
You can display context-sensitive help in several ways, depending on your context
in an application.

■ If a Help button exists, click it.

■ If a Help button does not exist, click the object that you are interested in, then
press F1.
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■ Some wizard pages for the change management applications also display
property pages. To access help for the wizard page, click the Help button at the
bottom left corner of the page. To access help for a property page, click a field in
the property page, then click the Help button beneath the property page. If a
Help button does not exist beneath the property page, click a field in the
property page, then press F1.

Finding a Particular Type of Help Topic
In addition to providing context-sensitive help, the Oracle Change Management
Pack help system contains conceptual topics, task topics, and a glossary. To locate
each type of topic:

■ Help topics whose titles begin with words such as "About," "Introduction,"or
"Overview" are conceptual topics. These topics usually provide overview
information about change management applications or conceptual information
that you should be aware of before performing a particular task. They do not
provide step-by-step instructions for accomplishing a task. The Conceptual
Topics book on the help system’s Contents page includes all of the conceptual
topics in the Oracle Change Management Pack help system.

■ Help topics whose title begin with the word "To" are task topics. These topics
provide step-by-step instructions for accomplishing a task. They do not provide
conceptual information that you should be aware of before performing the task.
The Task Topics book on the help system’s Contents page includes all of the
task topics in the Oracle Change Management Pack help system.

■ The Oracle Change Management Pack glossary is available by accessing the
Glossary book on the help system’s Contents page.
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6
Using Change Manager

The Change Manager application is the change management central interface.
Change Manager gives you direct or indirect access to all of the change
management operations (in cases where Change Manager cannot directly perform
an operation, such as capturing or comparing object definitions, Change Manager
starts the application that performs that operation).

Change Manager provides access to all the change management objects owned by
all users, and allows appropriate operations on these objects depending on
ownership.

Objects are ordered by owner in the Change Manager navigator tree. Each user has
read and write access to the object definitions that he or she owns, and has
read-only access to object definitions owned by other users.

Starting Change Manager
You can start the Change Manager application in any of the following ways:

■ From the Oracle Enterprise Manager console, use any of these methods:

– Select a database in the navigator panel, click the right mouse button, point
to the Related Tools menu option, then click Change Manager.

– On the Tools menu, point to Standard Management Pack, then click
Change Manager.

– Click the Standard Management Pack drawer, then click the Change
Manager icon.

■ On the Windows Start menu, point to Programs, then to the Oracle Home
where Oracle Enterprise Manager is installed, then to Standard Management
Pack, then click Change Manager.
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See "Starting Change Management Applications from Change Manager" on
page 6-2 for more information on starting the other change management
applications from Change Manager and "Starting DBA Studio from Change
Manager" on page 6-3 for more information on starting DBA Studio from Change
Manager.

Using the Change Manager Main Window
The Change Manager main window has a navigator tree on the left and a detail
view on the right.

The navigator tree displays the following change management objects, organized by
owner:

■ baselines

■ comparisons

If the Change Manager navigator tree contains no objects, this means that no
baselines or comparisons have been created in the Oracle Enterprise Manager
repository that Change Manager is connected to. When you create these objects,
they appear in the Change Manager tree.

When you select a change management object or object folder and click the right
mouse button, a context menu is displayed that lists the operations that can be
performed in the current context. If you select an object that you do not own, some
of the operations on the context menu are unavailable (for example, you cannot
remove or modify an object that you do not own, because you have read-only access
to objects owned by other users). On the context menu, choose any available
operation that you are interested in performing.

When the Change Manager Users folder (the root of the Change Manager tree) is
selected, the detail view provides information about change management
applications and the operations that they can perform. Click on an application’s
icon in the detail view to learn more about the operations that the application can
perform.

When other folders or objects are selected in the Change Manager tree, the detail
view provides related information about the selected folder or object.

Starting Change Management Applications from Change Manager
You start the other change management applications from Change Manager, as
follows:
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■ Baseline Viewer

Expand the Change Manager folder, user folder, and Baselines folder in the
Change Manager tree, select a baseline, then on the Object menu, click View
Baseline.

■ DB Capture

On the Change Manager Object menu, click Create Baseline.

■ DB Diff

On the Change Manager Object menu, click Compare Database Objects.

Starting DBA Studio from Change Manager
In some cases, you may want to start DBA Studio to quickly create or modify object
definitions. To start DBA Studio from Change Manager, on the Tools menu, click
DBA Studio.

Working with Baselines
Table 6–1 describes how to use Change Manager to perform different types of
baseline operations.

Table 6–1 Performing Baseline Operations

Operation Steps for Performing the Operation

Create a new baseline On the Change Manager Object menu, click Create Baseline
and follow the steps in the DB Capture application.

View a baseline Select the baseline in the tree. On the Change Manager Object
menu, click View Baseline.

Delete a baseline Select the baseline in the tree. On the Change Manager Object
menu, click Remove. This deletes all the versions of the
baseline.

Export a baseline to a file On the Change Manager Tools menu, click Export
Plans/Baselines/Comparisons, then specify the baseline to
export and the name of the export file.

Import a baseline from a
file

On the Change Manager Tools menu, click Import
Plans/Baselines/Comparisons, then specify the name of the
export file and the baseline to import.
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For more information on working with baselines, see:

■ "Viewing History Entries for Tasks" on page 6-5 for more information on
viewing history entries for baseline tasks.

■ "Working With a Particular Version of a Baseline or Comparison" on page 6-6
for more information on working with particular versions of baselines.

■ "Exporting and Importing Baselines and Comparisons" on page 6-7 for more
information on exporting and importing baselines.

Working with Comparisons
Table 6–2 describes how to use Change Manager to perform different types of
comparison operations.

Create a new version of a
baseline

Select the baseline in the tree. On the Change Manager Object
menu, click Recapture.

View a previous version of
a baseline

Select the baseline in the tree. On the Change Manager Object
menu, click Show Versions. In the Versions dialog box, click
the version you want to view, then click View.

Delete a previous version
of a baseline

Select the baseline in the tree. On the Change Manager Object
menu, click Show Versions. In the Versions dialog box, click
the version you want to delete, then click Remove.

View history entries for
baseline tasks

On the View menu, click Show History. In the History dialog
box, view history entries for completed baseline tasks on the
History page.

Table 6–2 Performing Comparison Operations

Operation Steps for Performing the Operation

Create a new comparison On the Change Manager Tools menu, click Compare Database
Objects and follow the steps in the DB Capture application.

View a comparison Select the comparison in the tree. On the Change Manager
Object menu, click View Comparison.

Delete a comparison Select the comparison in the tree. On the Change Manager
Object menu, click Remove. This deletes all the versions of the
comparison.

Table 6–1 Performing Baseline Operations (Cont.)

Operation Steps for Performing the Operation
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For more information on working with comparisons, see:

■ "Viewing History Entries for Tasks" on page 6-5 for more information on
viewing history entries for comparison tasks.

■ "Working With a Particular Version of a Baseline or Comparison" on page 6-6
for more information on working with particular versions of comparisons.

■ "Exporting and Importing Baselines and Comparisons" on page 6-7 for more
information on exporting and importing comparisons.

Viewing History Entries for Tasks
You can view history entries that show the status of the following change
management tasks:

■ Capturing baselines

■ Performing comparisons

By viewing the history entries for completed tasks, you can determine when each
change management task was performed and its completion status.

Export a comparison to a
file

On the Change Manager Tools menu, click Export
Plans/Baselines/Comparisons, then specify the comparison to
export and the name of the export file.

Import a comparison from
a file

On the Change Manager Tools menu, click Import
Plans/Baselines/Comparisons, then specify the name of the
export file and the comparison to import.

Create a new version of a
comparison

Select the comparison in the tree. On the Change Manager
Object menu, click Repeat Comparison.

View a previous version of
a comparison

Select the comparison in the tree. On the Change Manager
Object menu, click Show Versions. In the Versions dialog box,
click the version you want to view, then click View.

Delete a previous version
of a comparison

Select the comparison in the tree. On the Change Manager
Object menu, click Show Versions. In the Versions dialog box,
click the version you want to delete, then click Remove.

View history entries for
comparison tasks

On the View menu, click Show History. In the History dialog
box, view history entries for completed comparison tasks on
the History page.

Table 6–2 Performing Comparison Operations (Cont.)

Operation Steps for Performing the Operation
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To view the history entries for tasks in the current change management repository,
on the Change Manager View menu, choose the Show History option, which
displays the History dialog box. The History dialog box allows you to view
completed tasks.

Viewing Completed Tasks
Click the History tab of the History dialog box to view completed tasks.

The history entries on the History page of the History dialog box enable you to
track the change management tasks that have been completed. Each row on the
History page is a history entry for one completed task. The status for a particular
history entry tells you whether the task completed successfully or not.

On the History page, you can perform the operations shown in Table 6–3:

Working With a Particular Version of a Baseline or Comparison
After you create a baseline specification, you can use the specification to generate
multiple baselines over time. Similarly, after you create a comparison specification,
you can use it to generate multiple comparisons over time.

By default, when you select a baseline or comparison in Change Manager, any
operations you perform are carried out on the latest version of that object. In some

Table 6–3 Operations That Can be Performed on Completed Tasks

Operation Steps to Perform the Operation

Remove a task Select a task and click Remove.

Update the History page
display

Click the Refresh button. Any new completed tasks are
displayed.

View a task Select a task and click GoTo. The appropriate change
management application window is opened in the correct
context for viewing the task.

Save history entries to a
file

Click the Save List button. The Save List dialog box lets you
save some or all of the task history entries in a file. You have
the option of viewing and printing the information to be
included in the file before saving the file.

Sort history entries Click a column heading on the History page. The first time you
click a heading, the history entries are sorted in ascending
order, using the values in that column. If you click again on the
same heading, the history entries are sorted in descending
order, using the values in that column.
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cases, however, you may want to view or remove an earlier version of the object. To
do so, after you select the object in Change Manager, on the Object menu, click
Show Versions. This displays the Versions dialog box. In the Versions dialog box,
select the version of the object that you are interested in, then click View to view the
selected version of the object in the appropriate change management window or
click Remove to remove the selected version of the object from the Oracle
Enterprise Manager repository.

Exporting and Importing Baselines and Comparisons
You can export and import baselines and comparisons using Change Manager.
After you export one or more of these objects to a file, you can then import the
objects into another repository, which copies the objects from one repository to
another.

To export baselines or comparisons:

1. In Change Manager, on the Tools menu, click Export
Plans/Baselines/Comparisons.

2. In the Export Plans/Baselines/Comparisons dialog box, specify the object or
objects to export, then click Export.

3. In the Export Plans/Baselines/Comparisons to which file? dialog box, select a
file into which the selected objects will be exported, then click Save.

To import baselines or comparisons:

1. In Change Manager, on the Tools menu, click Import
Plans/Baselines/Comparisons.

2. In the Import Plans/Baselines/Comparisons from which file? dialog box,
identify the file that contains the object or objects that you want to import, then
click Open.

3. In the Import Plans/Baselines/Comparisons dialog box, select the object or
objects that you want to import, then click Import. If the import utility
discovers that any of the objects being imported has the same name as an
existing object in the current repository, you will be prompted to either rename
the object being imported or to cancel the import operation for that object.

Note: When you remove a version of a baseline or comparison,
the version numbers for the remaining versions of that object
remain the same.
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7
Using Oracle TopSessions

This chapter covers how you use Oracle TopSessions, including the following
topics:

■ Before You Start Oracle TopSessions

■ Starting Oracle TopSessions

■ Oracle TopSessions Main Window

■ Obtaining an Overview of Session Activity

■ Viewing Details About a Given Session

■ Customizing the Session Information You Display

■ Exiting Oracle TopSessions

Before You Start Oracle TopSessions
Before using Oracle TopSessions, it is best to ensure that the following views exist
on the database instance:

■ V$SESSION

■ V$STATNAME

■ V$SESSTAT

■ ALL_TAB_COLUMNS

■ V$OPEN_CURSOR

■ V$SQLTEXT

■ V$LOCK
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■ SYS.DBA_OBJECTS

■ V$ROLLNAME

■ PLAN_TABLE

■ ALL_CATALOG

■ AUDIT_ACTIONS

The first four tables of the list are essential; Oracle TopSessions cannot run without
them. The rest of the tables are required to use certain features of Oracle
TopSessions; however, you can still run Oracle TopSessions without them.

The smptsixx.sql scripts have been provided by Oracle Enterprise Manager to create
the required tables and views on each database you want to connect to from Oracle
TopSessions. The xx in the file name identifies the version of the database against
which the script should be run. For example, if you have an Oracle 7.3 database,
you would run the smptsi73.sql script against it, and if you have an Oracle 8.0
database, you would run the smptsi80.sql script against it. The script for each
database version is located in the $ORACLE_HOME\SYSMAN\ADMIN directory.
Run these scripts from the SYS account. For more information about running these
scripts, see the section on setting up Oracle TopSessions in "Setting Up TopSessions"
on page 2-4.

If the ALL_CATALOG view or the AUDIT_ACTIONS view does not exist on a
database, run catalog.sql against the database from the SYS account. This script is
located in the $ORACLE_HOME\RDBMSxx\ADMIN directory.

Starting Oracle TopSessions
You start Oracle TopSessions as you would any typical Oracle Enterprise Manager
application.

By default, the top n sessions in the main display are sorted by the session logical
reads statistic. If you want to change the sort statistic and / or the statistic filter,
choose Options on the Session menu. This displays the Options property sheet, on
which you can customize the session information displayed in the main display. See

Attention:  See "Before You Start Oracle TopSessions" on page 7-1
if an error message appears when you attempt to start Oracle
TopSessions.
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"Customizing the Session Information You Display" on page 7-17 for more
information about using the Options property sheet.

Figure 7–1  shows the Oracle TopSessions main window and the Options property
sheet.

Figure 7–1   Oracle TopSessions Main Window

If you are monitoring multiple databases, it is possible to start multiple Oracle
TopSessions connections to multiple database instances. The system resources of the
management console are the only constraining factors.

Oracle TopSessions Main Window
As Figure 7–1  shows, the Oracle TopSessions main window includes the following
components:

Note: The options that were selected when you last exited Oracle
TopSessions are automatically loaded the next time you start Oracle
TopSessions. These options are saved in ORACLE_
HOME\SYSMAN\TEMP\TOPSESS.OPT.
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■ Title bar

■ Menu bar

■ Toolbar

■ Main display

■ Status bar

The following sections describe each of these components.

Title Bar
The title bar of the Oracle TopSessions main window displays the name of the
application and the database instance to which an Oracle TopSessions connection
has been established. If no connection to a database instance currently exists, the
message "No database connection" is displayed in the title bar.

Toolbar
The toolbar of the Oracle TopSessions main window contains icons representing
certain Oracle TopSessions menu items, including the following: Change Database
Connection, Refresh, Toggle Manual/Auto Refresh, Session Details, Kill Session,
Options, and Help. If no Oracle TopSessions connection to a database instance
currently exists, all tools except the Change Database Connection and Help tools are
disabled. If a database connection does exist, the Change Database Connection,
Refresh, Toggle Manual/Auto Refresh, Options, and Help tools are enabled.

The Refresh Mode tool performs the same function as the Manual and Automatic
buttons on the Refresh page of the Options property sheet. When the Refresh Mode
tool is not pressed (default), manual refresh mode is enabled. When the Refresh
Mode tool is pressed, automatic refresh mode is enabled.

Enabling automatic refresh mode with the Refresh Mode tool enables whatever
refresh interval is set on the Refresh page of the Options property sheet. To adjust
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this interval, go to the Refresh page itself. See "Customizing the Session Information
You Display" on page 7-17 for more information.

Status Bar
The status bar of the Oracle TopSessions main window can include the following
information:

Left section
When a menu item has been selected, an explanation of the menu item appears in
this section of the status bar.

Right section
Displays the time of the last data refresh of the Oracle TopSessions main display.

Oracle TopSessions Menu Bar
The menu bar of the Oracle TopSessions main window includes the following
pull-down menus:

■ File

■ View

■ Sessions

■ Help

File Menu
The File menu items allow you to create new database connections  and exit Oracle
TopSessions.

The File menu includes the following commands:

Attention: The length of time a data refresh requires varies,
depending on the number of sessions connected to the database
instance. A database instance with 700 to 800 sessions logged on
would require about 10 seconds to refresh. Thus, an instance with
perhaps 1,000 sessions logged on, when automatically refreshed at
the default 10 second interval, would be in perpetual refresh mode.
Thus, if you plan to use the automatic refresh mode, it is very likely
that you will want to adjust the refresh interval to reflect your
particular environment.
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Change  Database Connection
Displays the Login Information dialog box, enabling you to connect to a database
instance of your choice.

Exit
Exits Oracle TopSessions.  See "Exiting Oracle TopSessions" on page 7-20 for more
information.

View Menu
The View menu items allow you to refresh the main window display and to
show/hide the toolbar or status bar.

The View menu includes the following commands:

Refresh
If manual refresh mode (default) is enabled, you can choose this command to
refresh (immediately) the session information displayed in the Oracle TopSessions
main window.

Toolbar
Allows you to show/hide the toolbar.

Status Bar
Allows you to show/hide the status bar.

Sessions Menu
The Sessions menu items allow you to specify what session statistics will be
displayed in the Oracle TopSessions main display, and how that information will be
refreshed.  See "Customizing the Session Information You Display" on page 7-17 for
more information about these menu items.

The Sessions menu includes the following commands:

Details
Displays the Session Details window for the session selected from the Oracle
TopSessions main display. This menu item is disabled when no session in the Oracle
TopSessions main display has been selected.

Kill
Kills the user session selected on the Oracle TopSessions main display.

When a session has been killed, a red "X" marks the username of that session. This
symbol is like the red "X" on the Kill tool icon.



Obtaining an Overview of Session Activity

Using Oracle TopSessions 7-7

Options
Displays the Options property sheet, from which you can specify the sorting
criterion, the refresh mechanism, and the number of entries for statistics displayed
in the Oracle TopSessions main window.

The length of time the data refresh requires varies, depending on the number of
sessions connected to the database instance. An instance with 700 to 800 sessions
logged on would require about 10 seconds to refresh.

If no Oracle TopSessions connection to a database instance currently exists, all of
these Session menu items are disabled.

Help Menu
The Help menu items allow you to obtain help on Oracle TopSessions menu items
or property sheets.

Contents
Displays an overview of the Oracle TopSessions help system.

Search for Help On
Displays an alphabetical list of Help topics.

Using Help
Displays information about using the Help system.

About Oracle  TopSessions
Displays the version number of this application.

Obtaining an Overview of Session Activity
Once populated with data, the Oracle TopSessions main display includes a
multi-column list of summary information for each session connected to the
database instance, or for each of the top n sessions, as measured by the selected sort
statistic. This information is obtained from the V$SESSION view, as follows:

SID
Oracle session ID for this session.

USERNAME
Oracle user name using this session.
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OSUSER
Operating system user name.

Sort Statistic
This fourth column varies, depending on the sort statistic you have selected.

COMMAND
Last Oracle command executed by this session.

STATUS
Status of this session: IDLE, ACTIVE, KILLED, or BLOCKED.

MACHINE
Identifier of the machine using this session.

PROGRAM
Name of the client program executing this session.

See "Customizing the Session Information You Display" on page 7-17 for
information about defining the top n sessions.

For information on the V$ views from which these statistics are derived, see the
Oracle Server Reference. For information on how to make use of these statistics, see
Oracle Server Tuning and Oracle Server Administrator’s Guide.

Using the Right Mouse Button on the Main Display
In the Oracle TopSessions main display, you can click on a username with the right
mouse button, and then select one of the following menu items:

Details
Displays the Session Details window for that session. See "Viewing Details About a
Given Session" on page 7-9 for more information.

Kill
Kills the selected session. This menu item works like the Kill menu item of the
Session menu.

Sorting the Order of Entries in the Main Display
By default, the value of the sort statistic determines the order of session entries in
the Oracle TopSessions main display. (The sort statistic is the fourth column of the
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multi-column list.) However, you can use any field in the list to sort the order of
displayed session entries, by clicking on any column header in the list.

Viewing Details About a Given Session
To obtain more information about a given session, you can drill down by double
clicking on an SID in the Oracle TopSessions main display. A Session Details
window for that session appears. This section covers the following topics:

■ Session Details pages

■ Session Details data refresh time

■ Viewing session details for multiple sessions simultaneously

Session Details Pages
The Session Details window includes the following pages:

■ General

■ Statistics

■ Cursors

■ Locks

To select one of these pages, click on the appropriate tab title near the top of the
Session Details window.

Session Details General Page
The General page of the Session Details window provides detailed information
about a session. This information is obtained from the V$SESSION view.

For information on the V$ views from which these statistics are derived, see the
Oracle Server Reference. For information on how to make use of these statistics, see
Oracle Server Tuning and Oracle Server Administrator’s Guide.

While the contents of the General page can vary, depending on the Oracle7 or
Oracle8 server release, for an Oracle 7.3 server, the General page contains the
following:

SADDR
Session address of this session.
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SID
Oracle session ID of this session.

SERIAL#
Serial number of this session.  Together with the SID, this number provides a
unique key for this session.

AUDSID
Auditing session ID.

PADDR
Address of the Oracle process using this session.

USER#
ID of the user using this session.

USERNAME
User name of the user using this session.

COMMAND
Last Oracle command executed.

TADDR
Address of the transaction state object.

LOCKWAIT
Address of lock waiting for; null if none.

STATUS
Status of this session: ACTIVE, IDLE, KILLED, or BLOCKED.

SERVER
Server type: DEDICATED, SHARED, PSEUDO, or NONE.

SCHEMA#
Schema user identifier.

SCHEMANAME
Schema user name.

OSUSER
Operating system user name.
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PROCESS
Process ID.

MACHINE
Identifier of the machine using this session.

TERMINAL
Operating system terminal name.

PROGRAM
Name of the client program using this session.

TYPE
Session type.

SQL_ADDRESS
Together with the SQL hash value, identifies the SQL statement that is currently
being executed.

SQL HASH VALUE
Together with the SQL address, identifies the SQL statement that is currently being
executed.

PREV_SQL_ADDR
Together with the previous SQL hash value, identifies the SQL statement that
executed previous to the SQL statement currently executing.

PREV_HASH_VALUE
Together with the previous SQL address, identifies the SQL statement that executed
previous to the SQL statement currently executing.

MODULE
Name of the currently executing module as set by calling the procedure named
DBMS_APPLICATION_INFO.SET_MODULE.

MODULE_HASH
The hash value of the above module name.

ACTION
Name of the currently executing action as set by calling the procedure named
DBMS_APPLICATION_INFO.SET_ACTION.
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ACTION_HASH
The hash value of the above action name.

CLIENT_INFO
Information set by the DBMS_APPLICATION_INFO.SET_CLIENT_INFO
procedure.

FIXED_TABLE_SEQUENCE
Number that increases every time the session completes a call to the database and
there has been an intervening select from a dynamic performance table.

ROW_WAIT_OBJ#
Object ID for the table containing the row ID specified in ROW_WAIT_ROW#.

ROW_WAIT_FILE#
Identifier for the datafile containing the row ID specified in ROW_WAIT_ROW#.
This column is valid only if the session is currently waiting for another transaction
to commit and the value of ROW_WAIT_OBJ# is non-zero.

ROW_WAIT_BLOCK#
Identifier for the block containing the row ID specified in ROW_WAIT_ROW#. This
column is valid only if the session is currently waiting for another transaction to
commit and the value of ROW_WAIT_OBJ# is non-zero.

ROW_WAIT_ROW#
Current row ID being locked.  This column is valid only if the session is currently
waiting for another transaction to commit and the value of ROW_WAIT_OBJ# is
non-zero.

LOGON_TIME
Logon timestamp for the session.

LAST_CALL_ET
Last call made during the session.

Session Details Statistics Page
The Statistics page of the Session Details window provides a large number of
performance statistics for the selected session. The particular statistics this page
displays can vary, depending on the Oracle server instance. These statistics are
obtained from the V$SESSTAT view.
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The selected category in the Category drop-down menu determines the statistics
that will be displayed for the current session.  To define a custom set of statistics to
display, click the Custom... button on the Statistics page.  Then use the Choose
Statistics for Display dialog box to select the set of statistics.  After you have chosen
a set of statistics, they are saved as the Custom category of statistics and the Custom
category is added to the Category drop-down menu.  Then, to select the Custom
category of statistics for display, select Custom from the Category drop-down
menu.  See "Choose Statistics for Display Dialog Box" on page 7-13 for more
information on choosing a custom set of statistics.

For information about the statistics that can be displayed for a session and the V$
views from which they are derived, see the Oracle Server Reference. For information
on how to make use of these statistics, see Oracle Server Tuning.

Choose Statistics for Display Dialog Box
The Choose Statistics for Display dialog box allows you to select a custom set of
statistics to display for a session.

The left tree view contains the list of statistics that are currently selected for display
in the Custom category on the Statistics page of the Session Details window.  The
right tree view contains the available statistics that can be selected for display in the
Custom category.  In the tree views, a + or - sign icon is used for the names of the
categories of statistics.  Click the + or - sign for a category of statistics to view or
hide the individual statistics in the category.

To move a category of statistics or an individual statistic from one tree view to the
other, double-click on the category or statistic.  Click OK when the left tree view
contains the set of statistics you want to display in the Custom category.  After you
have chosen a set of statistics, they are saved as the Custom category of statistics
and the Custom category is added to the Category drop-down menu on the
Statistics page of the Session Details window.  Then, to select the Custom category
of statistics for display, select Custom from the Category drop-down menu on the
Statistics page of the Session Details window.

You can modify the set of statistics in the Custom category by clicking the Custom...
button on the Statistics page of the Session Details window, then selecting a
different set of statistics using the Choose Statistics for Display dialog box.

The set of statistics in the Custom category are saved in $ORACLE_
HOME\SYSMAN\TEMP\TOPSESSC.INI.
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Session Details Cursors Page
The Cursors page of the Session Details window provides information about each
shared cursor in the shared SQL area for the selected session.

The Cursors page contains the following:

Show Cursors
Click on an item in this list box to display SQL statement(s) for the selected user
session. Options include:

Current Cursor: Displays the SQL statement currently executing.  This is the default.

All Cursors: Displays all SQL statements that have executed or will execute on the
database server for the selected user session.

Show Explain Plan
Click on this button to display the explain plan for the SQL statement in the Cursors
page display box which you have selected. See "Displaying an Explain Plan for a
User Session" on page 7-15 for more information.

Display box
Displays one or more SQL statements for the selected user session. If All Cursors
has been selected, the first SQL statement in the list is the statement currently
executing on the server for the session.

Attention: In order to view explain plans for SQL statements
accessing V$ views, you must log in as SYS. In addition, you must
have privileges to access the objects in the SQL statement for which
you want to view an explain plan.

Attention: If no SQL statement appears in this display box, but
you expect one to exist for the session, a problem may exist with an
important database table. See "Before You Start Oracle TopSessions"
on page 7-1 for more information.

Attention: Only SQL statements containing the commands
SELECT, INSERT, UPDATE and DELETE will produce explain
plans for you to view in this display box; any other SQL statement
will not produce an explain plan for you to view.
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Displaying an Explain Plan for a User Session
To display an explain plan for a user session, from the Cursors page of the Session
Details window, select a SQL statement and click on the Show Explain Plan button.
The Explain Plan For Session xx:y window appears.

The title bar of this window includes the SID (xx) of the session and the number of
windows opened on that session (y). This window includes the following elements.

SQL Statement
Displays the SQL statement for which you want to view the explain plan.

Explain Plan
The folders allow you to collapse or expand the level of detail of the explain plan.
This feature is particularly useful when analyzing long and/or complicated explain
plans.

Session Details Locks Page
The Locks page of the Session Details display provides information about locks
held or requested by a given session. This information is obtained from the
V$LOCK and V$ROLLNAME views.

For information about the V$ views from which these statistics are derived, see the
Oracle Server Reference. For information on how best to interpret and use these
statistics, see Oracle Server Tuning.

The Locks page includes the following list box:

Lock Types
Clicking on an item in this list box allows you to select the type of lock by which the
sessions will be displayed. Options include All Locks or Blocking/Waiting Locks.

The Locks page contains the following fields:

User Name
Oracle user name using the session.

Session ID
Oracle session ID for the session.

Note: The Expected Rows column only appears when an Oracle
7.3 database is being monitored.
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Lock Type
Type of lock, as follows: MR (Media Recovery); RT (Redo Thread); UN (User
Name); TX (Transaction); TM (DML); UL (PL/SQL User Lock); DX (Distributed
Xaction); CF (Control File); IS (Instance State); FS (File Set); IR (Instance Recovery);
ST (Disk Space Transaction); TS (Temp Segment); IV (Library Cache Invalidation);
LS (Log Start or Switch); RW (Row Wait); SQ (Sequence Number); TE (Extend
Table); and TT (Temp Table).

Mode Held
Mode in which the lock is currently held by the session, as follows: None; Null;
Row-S (SS); Row-X (SX); Share; S/Row-X (SSX); and Exclusive.

Mode Requested
Mode in which the lock is being requested by the process, as follows: None; Null;
Row-S (SS); Row-X (SX); Share; S/Row-X (SSX); and Exclusive.

Object Name
Name of the object, rollback segment, table or view, being locked. If the lock type is
TM, the object is a table or view. If the lock type is TX, the object is a rollback
segment.

Object Owner
Owner of the object that has been locked by the session. The session user, listed in
the Username field of the Session Details window General page, may be different
than the owner of the object being locked.

Object Type
Object type.

Object ID
Unique identifier of the object.

Resource ID 1
For certain types of locks, this value is the object ID or rollback segment number.
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Resource ID 2
Undocumented.

Session Details Display Refresh Time
Like the status bar of the Oracle TopSessions main display, the status bar of the
Session Details display also shows the refresh time for the information it displays.
This time reflects the refresh time of the Oracle TopSessions main display at the time
the Session Details display is created. Even when the Oracle TopSessions main
display is subsequently refreshed, the information in a Session Details window that
remains open during the main display refresh will not itself be refreshed.

Likewise, even though the refresh time in the status bar of the main window is
updated to reflect the most recent refresh, the refresh time in the status bar of an
open Session Details window is not updated simultaneously. Thus, the refresh time
in the Session Details window status bar continues to reflect the time the static
information in the Session Details window was captured.

Should you want to refresh the information for a given session in the Session
Details window, close the window and then double-click on the SID for that session
in the Oracle TopSessions main window. The resulting Session Details window will
reflect the latest refresh time of the Oracle TopSessions main display.

Viewing Session Details for Multiple Sessions
You can display, minimize (iconify), and maximize Session Details displays for
multiple sessions as you track down problems and work to resolve them.

Customizing the Session Information You Display
To customize how session information is displayed in the Oracle TopSessions main
window, choose Options from the Session menu. The Options property sheet that
appears includes the following pages:

■ Sort

Attention: If no information is displayed on the Locks page, it is
likely that no locks currently exist for the session. However, if you
suspect that locks exist, but no information is displayed on the
Locks page, a problem may exist with an important database table.
See "Before You Start Oracle TopSessions" on page 7-1 for more
information.
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■ Refresh

■ Count

To select one of these pages, click on the appropriate tab title near the top of the
Options property sheet.

Options Sort Page
Use the Sort page of the Options property sheet to specify how session information
displayed in the Oracle TopSessions main window will be sorted, and what time
interval the data will reflect. The Sort page contains the following:

Statistic Filter
Click on an item in this list box to specify the group of statistics from which to
choose then select a particular sort statistic in the Sort Statistic list box.

These groups of statistics are labeled as follows: Predefined, User (default), Redo,
Enqueue, Cache, Operating System, Parallel Server, SQL, Debug, Other, and All.

Selecting one of these items makes available a different group of statistics in the Sort
Statistics box. With the exception of the Predefined group, the mapping between a
statistic and its statistic filter group is derived from the CLASS column of the
dynamic performance table V$STATNAME.

The Predefined statistics are defined or calculated from statistics displayed on the
Statistics page of the Session Details display, as follows: CPU Usage (CPU used by
this session); File I/O (physical reads + physical writes); Memory (session uga
memory); Open Cursors (opened cursors current); User Transactions (user commits
+ user rollbacks).

Sort Statistic
Click on this list box to select the statistic by which the sessions displayed in the
Oracle TopSessions main window will be sorted. The contents of this list box vary,
depending on the Statistic Filter that has been selected.

Display Value
Current: Click on this button to specify that statistics displayed in the Oracle
TopSessions main window be based on the most recent data refresh.

Note: The options that were selected when you last exited Oracle
TopSessions are automatically loaded the next time you start Oracle
TopSessions. These options are saved in ORACLE_
HOME\SYSMAN\TEMP\TOPSESS.OPT.
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Delta: Click on this button to specify that displayed statistics reflect the difference
(delta value) between the most recent data refresh and the data refresh previous to
that.

Options Refresh Page
Use the Refresh page of the Options property sheet to specify how you want session
information displayed in the Oracle TopSessions main window to be refreshed. The
length of time the data refresh requires will vary, depending on the number of
sessions connected to the database instance. An instance with 700 to 800 sessions
logged on would require about 25 seconds to refresh.

The Refresh page contains the following:

Manual
Click on this button (default) to enable manual refreshing of the session information
displayed in the Oracle TopSessions main window. You can then use the Refresh
command from the View menu or the Refresh tool to refresh this information when
you so choose.

Automatic
Click on this button to enable automatic refresh of session information displayed in
the Oracle TopSessions main window; the Refresh Interval group of list boxes is
then enabled for use.

Refresh Interval
Click on the appropriate combination of the Seconds, Minutes and Hours list boxes
to specify the refresh interval for session information displayed in the Oracle
TopSessions main window. The default refresh interval is 10 seconds.

Attention: The refresh interval is the time interval measured from
the beginning of a refresh to the beginning of the refresh following
it. Thus, a database instance with perhaps 1,000 sessions logged on,
and being automatically refreshed at the default 10 second interval,
would be in perpetual refresh mode. Thus, if you plan to use the
Automatic refresh mode, it is very likely that you will want to
adjust the refresh interval to reflect your particular environment.
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Options Count Page
Use the Count page of the Options property sheet to specify the number of sessions
to be displayed in the Oracle TopSessions main window. The Count page contains
the following:

Display All Sessions
Click this button to display all sessions connected to the database instance. As this
option is very resource-intensive in almost all cases, Oracle Corporation
recommends that you use the default option Display Top N Sessions.

Display Top N Sessions
Click on this button (default) to display the top n sessions that meet the sort statistic
criterion specified in the Sort page of the Options property sheet. The default
number of sessions is 10. Click on the scroll box to the right of this button to specify
the value of n.

Exiting Oracle TopSessions
To exit Oracle TopSessions, choose Exit from the File menu. A dialog box is
displayed, confirming that you want to close your Oracle TopSessions session.
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A
Troubleshooting Appendix

This appendix describes different ways of troubleshooting problems that may occur
when you are using change management applications.

You may decide to contact an Oracle Worldwide Customer Support representative
regarding a problem with the change management applications. If so, you may be
asked to use one of the approaches described in this appendix to obtain information
that will help the representative determine the source of the problem.

Using Environment Variables When Running Change Manager from the
Command Line

You can set environment variables in the MS-DOS command line before you run the
Change Manager application from the command line. The following environment
variables may provide information that is useful for troubleshooting and debugging
change management application problems:

■ set ORACLE_OEM_JAVAMX=-mx<number>m

The default is -mx128m. This environment variable specifies the maximum
amount of virtual memory to be used by the Java Virtual Machine (in
megabytes). This memory is not used unless needed. If the amount is exceeded,
execution will be terminated. This environment variable can be used to increase
the amount of memory for large script generations and other purposes.

■ set ORACLE_OEM_CLIENTTRACE=<any text>

This environment variable causes an MS-DOS window to be displayed.
Sometimes, useful troubleshooting information will be displayed in this
window. Note that you must type some text after the equal sign for this
environment variable to work properly. The environment variable works
properly as long as you enter some text.
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■ set ORACLE_OEM_JAVARUNTIME=<directory where bin\java.exe is located>

You can specify this environment variable if you have a Java development
environment. This environment variable can be useful when the system is
hanging and you want to get a thread dump.

You can run the Change Manager application from the MS-DOS command line. To
do so:

1. From the Windows Start menu, point to Programs, then click Command Prompt
to display an MS-DOS window.

2. Set the working directory to the bin subdirectory of the Oracle installation
directory (ORACLE_HOME) for Oracle Enterprise Manager, for example:
\OEM_21\bin.

3. Start the Oracle Management Server if it is not already started, or make sure
your system has access to an Oracle Management Server running on a different
system.

4. Run the Change Manager application by typing the following in the MS-DOS
window:

oemapp ocm

5. After Change Manager starts, you can start any of the other change
management applications from Change Manager in the usual manner.

Enabling Tracing and Debugging for Change Management Applications
You can turn on tracing and debugging facilities for the change management
applications to help troubleshoot problems.

The ocm.properties file in the ORACLE_HOME\sysman\ocm\bin directory for
Oracle Enterprise Manager contains a number of properties that you can set to
provide more information about change management applications. Table A–1
displays the properties and a description of each property.

Note: The OCM_TRACE property described in Table A–1 must be
set to true for the troubleshooting information to be displayed in
the MS-DOS window.
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Note: The other properties in the ocm.properties file whose names
begin with OCM_TRACE are meaningful only when the OCM_
TRACE property is set to true.

Table A–1 Using the ocm.properties File to Enable Tracing and Debugging

Property Description

OCM_TRACE If true, enables output of informational and problem
trace messages.

OCM_TRACE_FILE If true, enables output of trace information to a file.
The setting of the OCM_TRACE_VERSIONING
property determines the name of the trace file.

OCM_TRACE_VERSIONING The OCM_TRACE_FILE property must be true for the
OCM_TRACE_VERSIONING property to be
meaningful.

If the OCM_TRACE_VERSIONING property is true, a
new version of the trace file is created for each run of
the application. The file has a name of the format
Oracle Change Manager_nnnnnn.log.

If a change management application is running in
more than one session on your machine, examine the
timestamp of each trace file to determine the trace file
that is associated with each session. The trace file with
the earliest timestamp is the trace file for the session
that started first, and so on.

If the OCM_TRACE_VERSIONING property is false,
the trace file has the name Oracle Change
Manager.log, and the file is overwritten for each run
of the application.

OCM_TRACE_DEBUG If the OCM_TRACE_DEBUG property is true, general
debugging information (such as property values) is
output to the trace file at application startup time.

OCM_TRACE_DEBUG_VERBOSE If the OCM_TRACE_DEBUG_VERBOSE property is
true, more detailed debugging information, including
class names and line numbers, is output to the trace
file at application startup time.

VDB_DEBUG If the VDB_DEBUG property is true, database calls
are output to the trace file.
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By default, the trace files for change management applications are written to the
ORACLE_HOME\sysman\log directory for Oracle Enterprise Manager.

VDB_VERBOSE_DEBUG If the VDB_VERBOSE_DEBUG property is true, more
detailed information about database calls, including
SQL statement issued and return values, is output to
the trace file.

Table A–1 Using the ocm.properties File to Enable Tracing and Debugging (Cont.)

Property Description
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